
aPriori Professional  
Installation Guide 
For On-Premise Only 

Version 2019 R2 
 

 

 

Commented [BF1]: I have made a first pass at updatng this 
document for 19.2 and covering the new installation wizard. 
However, there are section like upgrades that must be verified 
and probably updated in view of the new Wizard. I’ve place 
Word comments in locations where I think more work may be 
required. 



 

Copyright 

Copyright © 2019, aPriori Technologies, Inc. All rights reserved. aPriori Technologies, Inc., 300 
Baker Avenue, Concord, MA 01742, USA.  

Portions of this software were created under the direction of Professor Michael Philpott in the 
Department of Mechanical and Industrial Engineering at the University of Illinois at Urbana-
Champaign.  

Portions of this software copyright © 2000-2019 Tech Soft 3D.  
Portions of this software copyright © 1995-2019 MySQL AB.  
Portions of this software copyright © 2003-2019 Spatial Corporation. 
Portions of this software copyright © 2006-2019 Siemens PLM.  

The following trademarks and service marks are the property of aPriori Technologies, Inc.: 
aPriori, Cost Ticker, True Cost Convergence, Cost Insight.  

Portions of this software contain copyrighted information of third parties. Title thereto is retained, 
and all rights therein are reserved, by the respective copyright owner. Third party software 
included with the product is identified below. 

Document usage 

This publication, as well as the software described in it, is provided under license and may only 
be used or copied in accordance with the terms of such license. The content of this publication is 
provided for informational use only. It is subject to change without notice and should not be 
construed as a commitment by aPriori Technologies, Inc. aPriori Technologies, Inc. assumes no 
responsibility or liability for any errors or inaccuracies that may appear in this publication.  

Except as permitted by license, no part of this publication may be reproduced, stored in a retrieval 
system, or transmitted, in any form or by any means, without the prior written permission of 
aPriori Technologies, Inc.  

The text and drawing set forth in this publication are the exclusive property of aPriori 
Technologies, Inc. 

Third parties 

Unless otherwise noted, all references to company names in sample text are designed solely to 
document the use of aPriori Technologies, Inc. products.  

The brand names and product names used in this publication are the trademarks, registered 
trademarks, service marks, or trade names of their respective owners. aPriori Technologies, Inc. 
is not associated with any product or vendor mentioned in this publication unless otherwise noted.  

This product includes additional third-party software. All required third party and related software 
licenses and attribution are included with the aPriori software. For a complete list, see file 
“notices.txt” in the third party-licenses sub-directory of the aPriori installation directory. 

Software rights 

The software is provided with Restricted Rights. Duplication by or disclosure to the U.S. 
Government is subject to the restrictions as set forth in FAR 12.212 and DFAR 227.7202 related 
to Commercial Computer Software and Commercial Computer Software Documentation, as 
applicable. Licensee agrees to always include such legends whenever software is, or is deemed 
to be, a deliverable under such a contract. The manufacturer is aPriori Technologies, Inc. with 
offices at 300 Baker Avenue, Concord, MA 01742. 

Document Information  

Last updated July 13, 2020  

The latest version of this document can be found at the aPriori Support Help Center (requires 
registration): https://support.apriori.com/hc 
 

https://support.apriori.com/hc


Contents  aPriori Installation Guide 

aPriori Professional 
Version 2019 R2 aPriori Confidential i 

CONTENTS 
 

About This Guide v 

Overview .............................................................................................................. vi 
Related documents .............................................................................................. vi 
Typographic conventions ..................................................................................... vi 
Feedback and customer support ......................................................................... vii 

1 Planning Your Installation 8 

Releases and Installation Types ........................................................................... 8 
Upgrade paths ............................................................................................................... 8 

Acquiring the Installation Files ............................................................................... 8 
To download and extract installation files 9 

Summary of Required Procedures ...................................................................... 10 
Understanding release versions .......................................................................... 11 

Interoperability ........................................................................................................... 11 

Understanding installation types ......................................................................... 12 

2 First-Time Installations 14 

Planning a First-Time Installation ........................................................................ 14 
Deployment Options ................................................................................................... 14 

Client Deployment Options 14 

Database Deployment Options 15 

Managing Deployments 15 

Recommended Standard Deployment 16 

Advanced deployments 16 

Installing Prerequisite Software ........................................................................... 17 
Prerequisite Database Software ................................................................................. 17 
Clients .......................................................................................................................... 17 
Installing a CAD Application ........................................................................................ 17 

Installing and Configuring a Database ................................................................ 18 
MySQL Installation and Configuration ........................................................................ 18 

Installing MySQL Server on Windows 18 

To begin MySQL server installation on Windows (MySQL Win Part 1) 18 



 

aPriori Professional (On-Premise) 
Version 2019 R2  aPriori Confidential ii 

MySQL Server Configuration screen (MySQL Win Part 2) 19 
MySQL Workbench (MySQL Win Part 3) 20 
Import standarddata.sql (MySQL Win Part4) 21 
Create a user and assign privileges (MySQL Win Part 5) 21 
FOR ENTERPRISE PLATFORM ONLY - Edit the startup file (MySQL Win 
Part 6) 21 
Restart the MySQL service (MySQL Win Part 7) 22 
Anti-virus Software Exceptions for MySQL (MySQL Win Part 8) 22 

Installing MySQL on Linux 22 

MySQL Client Components (MySQL Linux Part 1) 22 
MySQL Server Components (MySQL Linux Part 2) 23 
Securing MySQL on Linux (MySQL Linux Part 3) 23 
MySQL Options File in Linux (MySQL Linux Part 4) 24 
Creating the aPriori database and users in Linux (MySQL Linux Part 5) 25 

Oracle Installation and Configuration ......................................................................... 26 

Installing Oracle 26 

To install and configure Oracle 26 
To import the Oracle data files 28 

Additional Oracle information 28 

SQL Server Installation and Configuration .................................................................. 28 

Installing SQL Server 28 

To install and configure SQL Server 29 
To create a SQL Server database instance 30 

aPriori Client Installation Adjustments 32 

A Note About Deleting SQL Server Databases 33 

Installing the aPriori Professional Client .............................................................. 34 
Before You Begin ......................................................................................................... 34 

Install by Using the aPriori Professional Setup Wizard ....................................... 34 
Welcome screen .................................................................................................. 35 
License Agreement ............................................................................................. 36 
Select Destination Directory ................................................................................ 36 
Select Components ............................................................................................. 39 
Document Cache Configuration .......................................................................... 41 
Database Schema Configuration ........................................................................ 42 

Schema Verification .................................................................................................... 43 
Oracle ONLY – SID vs. Service Name ........................................................................... 44 
SQL Server ONLY – Authentication Style ..................................................................... 44 

Memory Configuration ......................................................................................... 45 



 

aPriori Professional (On-Premise) 
Version 2019 R2  aPriori Confidential iii 

Creo and Pro/ENGINEER Configuration ............................................................. 47 
aPriori Properties Configuration .......................................................................... 48 
Bulk Costing Plug-In Properties Configuration .................................................... 50 
About to Install ..................................................................................................... 52 
Installation in Progress ........................................................................................ 53 
Installation Done .................................................................................................. 54 

Faster subsequent installations 54 

Uninstalling .......................................................................................................... 55 
Uninstaller Welcome screen ....................................................................................... 55 
Uninstall in Progress .................................................................................................... 56 
Uninstall Done ............................................................................................................. 57 

More on File Permissions .................................................................................... 57 
Silent Client Install ............................................................................................... 58 
Configuring and Starting aPriori .......................................................................... 59 

Load the License File ................................................................................................... 59 
To load the license: 59 

Add aPriori User Accounts .......................................................................................... 60 
Starting the CAD-Independent Client .......................................................................... 60 
Starting the Direct Integration Client .......................................................................... 60 

To expand to aPriori Desktop 60 
To manually disconnect from the CAD system: 60 
To manually connect to the CAD system: 60 

Configuring the Test and Training Databases ............................................................. 60 

Installing the CAD Plugin ..................................................................................... 62 
Pre-requisites .............................................................................................................. 62 
Installation ................................................................................................................... 62 
Editing the Configuration ............................................................................................ 63 
Silent Installation ......................................................................................................... 63 

To install silently 63 
To uninstall silently 63 

Installation Checklist ............................................................................................ 64 
Database ..................................................................................................................... 64 
Client ........................................................................................................................... 64 

3 Update Installations 65 

Back Up and Update the aPriori Professional Client ........................................... 65 
Overview of Database Upgrades ........................................................................ 66 

Types of upgrades ....................................................................................................... 66 
Which method should I choose? ................................................................................. 66 
Upgrading in a Test Environment ................................................................................ 67 
MySQL considerations ................................................................................................. 67 
Definition of Terms ..................................................................................................... 67 
General prerequisites .................................................................................................. 67 

Update – Test Environment ................................................................................. 68 
Prepare for the test update ........................................................................................ 68 



 

aPriori Professional (On-Premise) 
Version 2019 R2  aPriori Confidential iv 

Update Deployment Links ........................................................................................... 69 
Continue with the update process .............................................................................. 70 
Perform the database upgrade procedure ................................................................. 70 

Run the upgrade script 71 
Run the Compatibility Script ....................................................................................... 72 
Install the VPE baseline update ................................................................................... 72 
Acquire and install Regional Data Libraries ................................................................. 73 
Extensively test the update ......................................................................................... 73 

Update – Production Environment ...................................................................... 74 
Prepare for the production upgrade ........................................................................... 74 
Perform the update, adjusting as necessary ............................................................... 74 

A. Performing a Full Database Migration 75 

Prerequisites for migration .................................................................................. 75 
Overview of Steps ............................................................................................... 76 
Data Export ......................................................................................................... 76 

Set up the Source Version ........................................................................................... 76 
Export data out of the Source Version ........................................................................ 81 

Data Import .......................................................................................................... 82 
Setup the target version .............................................................................................. 82 
Import the data into the target version ...................................................................... 83 

Testing ................................................................................................................. 85 
Test the VPEs ............................................................................................................... 85 

Moving to production ........................................................................................... 86 
Plan and Schedule Production Changes ...................................................................... 86 
Upgrade the Client Software ....................................................................................... 87 

B. Migration by Support 88 

Overview of steps ................................................................................................ 88 
Exporting, importing, and testing ......................................................................... 89 
Moving from Testing to Production ...................................................................... 90 

C. Troubleshooting aPriori as a Creo Toolkit Application 92 

No Error Message ............................................................................................... 92 
aP Wrapper Failure ............................................................................................. 92 

D. SQL Server Export Tools 93 

Export using SQL Server Management Studio (SSMS) ...................................... 93 
Exporting using aPriori’s PowerShell script ......................................................... 94 



 

aPriori Professional 
Version 2019 R2 aPriori Confidential v 

About This Guide 

This document is for On-Premise installations. It explains how to install, update, 
and configure aPriori Professional and its related databases. Cloud installations 
are handled by aPriori personnel and are not covered herein. 

Key topics include: 

▪ Overview 

▪ Related documents  

▪ Typographic conventions 

▪ Feedback and customer support 
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Overview 
This Installation Guide contains detailed information about installing, updating, and 
configuring aPriori Professional. 

Related documents  
For more information about aPriori Professional see: 

▪ aPriori Professional User Guide – aPriori Professional on-premise user guide. 

▪ aPriori Cost Model Guide – Process groups user guide, which includes a chapter 
on direct and indirect overhead. 

▪ aPriori System Administration Guide – System Admin toolset reference and 
users guide. 

▪ aPriori VPE Administration Guide – Virtual production environment (VPE) toolset 
administration maintenance and deployment guide. 

▪ aPriori CMWB User Guide – Cost Model Work Bench (CMWB) customization 
guide. 

▪ aPriori Professional Release Notes – Summary of new features, feature 
enhancements, and performance and robustness improvements for aPriori 
Professional. 

▪ aPriori System Requirements – List of minimum and recommended software 
requirements for running aPriori Professional, Enterprise Platform, and the CAD 
file formats supported by aPriori. 

Typographic conventions 
The following conventions are used in this guide to convey additional information. 
 

Style  Application Example 

Code Literal text. The text appears exactly as 
shown. Usage includes commands, 
directory names and paths, file names, and 
system information. 

E:\setup.exe 

 

Italic 

code 
Values that you specify. For example, you 
need to supply a value for your file in the 

path name example to the right. 

C:\aPriori\your_file 

 

GUI Objects in the aPriori interface The Document field … 

 

GUI Action Interaction objects in the aPriori interface Click OK. 

 

Commented [LC2]: Courier new,  
Courier new, italic, 
Arial Narrow Bold 
Arial Bold 
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Note Notes highlight information, provide supplementary information, offer efficient or 
easy ways to perform tasks, or explain how to prevent errors or data loss. 

Feedback and customer support 
We appreciate your comments about this guide. Please contact us with your comments, 
questions, and requests for technical support. 

 

Website: http://www.apriori.com/support 

Email: support@apriori.com 

 

 

 

Commented [LC3]: Warnings should do this 
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1 Planning Your 
Installation 

Releases and Installation Types 
This document applies to ONLY On-Premise installations. If you have purchased aPriori 
Professional for Cloud, these procedures are handled by aPriori. 

Note: aPriori Professional Release 2019 R2 introduces a new Installer wizard. If you 
Some of the procedures are different than the procedures for prior installations of 
aPriori Professional. 

This document covers the following types of installation: 

▪ Performing a first-time installation 

▪ Updating an existing installation 

Updates/upgrades involve either a: 

▪ Maintenance (minor) release update to an existing installation. These typically do 
NOT include a database upgrade. (But sometimes they do.) 

▪ Major release update to an existing installation. These typically DO include a 
database upgrade. 

Updates typically involve some of the same procedures as a first-time installation. When 
updating, you must also: 

▪ Run a compatibility script to ensure that updated clients are compatible with the 
database. All updates require this procedure. 

▪ Perform a database upgrade procedure to ensure that changes in the database 
schema are reflected. Major release updates typically require this procedure. 

Upgrade paths 

Every release typically offers direct upgrade paths from at least the previous one or two 
releases. You can upgrade directly to 2019 R2 from: 

▪ 2019 R1 (19.1.x.x, including 19.1.0.0, 19.1.1.0, 19.1.1.1, 19.1.1.2, 19.1.2.0) – 
Requires updateDB<vers>.cmd. 

To upgrade from a release that is earlier than 2019R1, you must perform multiple 
upgrades, one for each major release. For help with upgrading from a release that is 
earlier than 2019 R1, please contact aPriori Customer Support or Professional Services. 

Acquiring the Installation Files 
To perform any type of installation, you must acquire the installation files. 

Commented [BF4]: Confirm with section with Lorna and 
Rachel. 

Commented [BF5]: Confirm this section with Imbi in 
Support. It may have changed due to the new installer. 
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aPriori Customer Support or Professional Services can tell you how to acquire the 
required installation files. Typically, you download the installation files from web links that 
aPriori provides. The links can point to either a specific version or to the latest version of 
the installation files.  

The main file is for installing aPriori Professional:  

aPriori-<version>.zip  

For releases that require database upgrades, you must also download a .zip file: 

aPriori-databases-<version>.zip 

In these file names: 

<version> is the release number, so that the full file name is similar to "aPriori-

16.2.0.0.zip" or "aPriori-16.2.1.0.zip", or “aPriori-database-17.1.0.1”, etc. 

Note: In older releases use more verbose version formats, such as "aPriori-
2014R1SP1.zip". This file-naming convention is being phased out. 

aPriori-<version>.zip contains the following: 

aPriori-setup.exe – installer for aPriori 

aPriori-databases-<version>.zip contains the database dump files for Oracle, 

MySQL, and SQL Server: standarddata.sql and, if required, migrationdata.sql. 

if you have purchased MySQL, aPriori also provides this file: 

mysql-installer-commercial-<version>.msi 

 
Note: The mysql-installer-commercial-<version>.msi file is for 64-bit Windows 

operating systems. If you require a Linux-supported file, please notify aPriori Customer 
Support at support@apriori.com. 

To download and extract installation files 

1 To download the aPriori client and database installation files, follow the instructions 
you receive from aPriori Customer Support. The instructions include a browser link to 
a site that contains downloads of the installation files. 

2 aPriori Customer Support may also direct you to download other files, such as 
updated aPriori Base Machining or Regional Data Library files. Download those files 
as necessary. 

3 Extract the contents of the .zip files and take note of their locations. You must be 
able to access them to complete the procedures in this document. 

Once you have downloaded and extracted the necessary files, you can proceed to the 
sections of this Installation Guide that pertain to your situation. 
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Summary of Required Procedures 
To understand the different types of aPriori releases and the options that you have for 
installing them, read the rest of this chapter. If you prefer to install without first reviewing 
all the options, refer to the table: 

Release 2019 R2 (19.2.x.x) is a MAJOR release: 

To Chapter Sections 

Install aPriori for the first time 2. First-Time Installations All 

Upgrade from aPriori 2019 R1 
(19.1.x.x) including SP1 
(19.1.1.x) or SP2 (19.1.2.x) or 
their hot fixes, to 2019 R2 
(19.2.x.x) or its hot fixes AND 
retain your database system. 

 

3. Update Installations All  

NOTE: You must perform the 
updateDB.cmd database upgrade 
procedures in this chapter. 

Update from aPriori 2019 R1 
including SP1 or SP2 or their hot 
fixes AND change your 
database system (for example, 
changing from MySQL to SQL 
Server).  

3. Update Installations Most of the procedures but do NOT 
include the database upgrade 
procedures in this chapter. 

Instead, perform a full migration, as 
covered in: 
Appendix A, Performing a Full 
Database Migration  

For Future 19.2 maintenance 
releases: 

Upgrade from aPriori 2019 R2 
to a 2019 R2 Service Pack or 
Hot Fix  

3. Update Installations IF APPLICABLE PER SUPPORT: 
You must perform the 
patchDB<vers>.cmd database 
patch upgrade procedure in this 
chapter. 

Upgrade from a version earlier 
than 2019 R1. 

 Contact aPriori Customer Support.  

Note: Installation documentation 
prior to 16.1 consists of three 
different documents: 

• Installation Guide 

• Service Pack Installation  

• Database Upgrade and 
Migration.  

Commented [BF6]: When 19.2 nears release, it’s critical to 
get this section validated by QA and Support. Sections in here 
can change from release to release. 
When 19.2.1 eventually get released, you may need to look at 
previous Service Pack installation Guides to see how the text 
can change. 
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Understanding release versions 
You can identify major and maintenance (minor) releases by their version numbers. The 
first two numbers (year and release number) identify a major release. The third and 
fourth numbers in a version identify Service Pack and Hot Fix maintenance releases: 

▪ Examples of major releases: 2018 R3 (18.3.0.0) ), 2019 R1 (19.1.0.0), 

▪ Examples of Service Pack maintenance releases: 2018 R1 SP1 (18.1.1.0), 2019 
R1 SP2 (19.1.2.0) 

▪ Examples of Hot Fix maintenance releases: 2017 R1 F1 (17.1.0.1), 2018 R3 F1 
(18.3.0.1) 

▪ Examples of Major and Service Pack releases when the discussion includes any 
of their Hot Fix releases: 2018 R3 SP1 Fn (18.3.1.x), 2019 R1 Fn (19.1.0.x) 

Trailing zeros are sometimes omitted, such as “18.2.1” and “19.1”, 

Note that once a hot fix release is available, it typically becomes the official shipping 
version rather than the original major release. For example, once 2017 R1 F1 became 
available, 2017 R1 stopped shipping and was replaced by 2017 R1 F1.  

First-time installations and major updates to existing installations can be performed with 
either major or maintenance releases, depending on where the product is in its lifecycle. 
That is, if you are currently running 2018 R2 and want to upgrade to the latest version of 
2019 R1, install whatever maintenance release is current. 

Note: Throughout this document, when the specific version that you must enter or type 
is critical, the exact version is shown. However, when general naming syntax is 
being discussed and an example is shown, the example does not necessarily 
reflect the specific current release. For example: 

Change the name of the installation from the default of “apriori” to also include the 
version (for example, “apriori2017R1”). 

If the current release is 2018 R3 SP1, then substitute the correct version, as in 
“apriori2018R3SP1”. 

Interoperability 

Maintenance upgrades typically allow for interoperability between clients running 
different versions within the same major release.  

EVERY release requires that you at least UPDATE the aPriori database with a 
“compatibility script” to enable it to work with clients running the most recent version of 
aPriori software. (The script sometimes needs to be run in other situations.) SOME 
maintenance releases (typically Service Packs) may also require you to UPGRADE the 
aPriori database. EVERY major release requires a database UPGRADE. 

For example, aPriori Professional clients running versions 2018 R1, 2018 R1 SP1, and 
2018 R1 SP2 are all compatible with a database that is updated or upgraded to 2018 R1 
SP2. However, 2018 R1 SP2 clients are not compatible with a database that is not 
updated beyond 2018 R1 SP1. 

Note: Interoperability is NOT available between different major releases.  

Commented [BF7]: These examples are getting a little old. 
It would be nice (but not critical) to update them to more 
recent versions.  

Commented [LC8R7]: Change for 2020 R1 

Commented [BF9]: UPDATE THIS SECTION for 19.2 WITH 
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Service Packs and Hot Fixes.  
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Understanding installation types 
There are two types of aPriori Professional installations: 

• First-time installation 

• Update (or upgrade) installation 

There are also two types of aPriori Professional updates: 

• Maintenance release update 

• Major release update 

An aPriori first-time installation is the Installation of an aPriori Professional major release 
on a machine that contains no previous aPriori releases. First time installation steps are: 

• Plan the deployment 

• Install: 

a. Prerequisite software  

b. A database 

c. Your aPriori clients 

• Test in non-production environment to ensure that your installation is 
complete 

• Move to a production environment 

 

A maintenance release is a minor update for a specific, previously installed major 
release. A major release installation is the installation of a new a Priori major release on 
a machine that contains the previous aPriori major release. The installation steps for 
updates are like the first-time installation steps. The major difference between first-time 
and update installations are: 

• For update installations, you typically do not need to install prerequisite software. 
However, you may have to update to a newer version of the prerequisite 
software. 

• For maintenance updates, you typically do not have to update the database. 

 

The table shows the requirements for each installation and release type 

 

Type Requirements 

Installation Release Install / Update Run 

  Prerequisite 
Software 

aPriori 
Client  

Database  Compatibility 
Script 

Installation 
Test 

First time Major x x x x x 

Update Maintenance AR NA AR x x 

 Major AR NA x x x 

 AR – As required 
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 NA – Not applicable 

Note:  Updates can only occur directly from the previous major release.  

If the release that is installed on your machine is older than the previous release, you 
must first upgrade and test each intermediate release. You cannot skip intermediate 
releases. For example, you cannot install a 2019 R2 version of aPriori Professional 
as a major update to a 2018 R2 version of the software that is installed on your 
machine. In this case, you must install and test the 2019 R1 version before you 
install and then test, the 2019 R2 version of aPriori Professional. 

You also cannot just go through the motions of upgrading an intermediate release 
and then immediately proceed to the next upgrade. aPriori Customer Support can 
help you move from an older release to the current one. 
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2 First-Time 
Installations 

Planning a First-Time Installation 
This chapter contains a high-level overview for a basic, on-premise deployment of 
aPriori Professional. For more detailed deployment information, see the aPriori System 
Administration Guide.  

For information about supported platforms and CAD systems, see the aPriori System 
Requirements document. 

Note: Procedures in this chapter that also apply to upgrade installations., such as 
Installing the aPriori Professional Client, are cross-referenced to the update 
chapter. 

Deployment Options 

aPriori Professional is typically deployed as client software where aPriori is run on 
workstations that connect to a central database. In this configuration, there is no 
application server–a server is required only to host the database. Both the aPriori 
Professional client and the aPriori database are required.  Flexible deployment options 
exist for both the database and client deployments. 

An application server may be required for bulk costing or Enterprise Platform modules 
such as Cost Insight Report, Cost Insight Admin: Scenario Synchronization or LDAP 
Synchronization, or Cost Insight Design. 

Client Deployment Options 

Document Cache – To improve aPriori performance, save a local version of your VPE 
data in a cache folder.  

Saving VPE data locally eliminates the need to extract large amounts of data from the 
database each time a part is costed. Extracting large amounts of data from the database 
can diminish performance, especially when the clients and the database server are in 
different LANs. 

You can specify the location of the document cache folder during client installation, 
choose one of these three options: 

▪ User Profile – The cache location is the home directory of the user, typically 
C:\Users\<username>\appdata\local\apriori. This option is the default.  

▪ aPriori Installation Directory – Select this location to place the cache in the 
same folder as all the aPriori application files. Before you select this option, make 
sure that the user has write permission to that location.  

Note: By default, in Windows 7 and later, users do not have write permission to 
the ‘Program Files' folder. 



First-Time Installations  aPriori Installation Guide 

aPriori Professional (On-Premise) 
Version 2019 R2  aPriori Confidential 15 

▪ Custom – Specify a custom location for the document cache directory. If you 
install aPriori locally on each computer, but want users to share the cache 
location, use this option. The cache location should be a network share that is 
located within the same LAN as the users. 

If you choose tis option, only a single cache location requires updating when 
VPEs are updated. However, during costing, each user could experience slightly 
lower performance because the data pull is across a network. 

Note: The user must have read/write access to the document cache directory. 
Therefore, if you select a network location or the Program Files directory on the 
local computer, the Windows folder permissions must be set to allow read/write 
permission. 

By default, you also have the option to disable the Document Cache Cleaner. Disable 
this option only if you set up a shared document cache and automate the updating of the 
document cache. 

To automate the updating of the document cache, run the updateDocCache.cmd script 
in the aPriori\bin\ directory. Before running the script, edit it and add the aPriori user 

ID and a password. You can set up the script to be run by a Windows Scheduled Task 
on a periodic basis. 

Database Deployment Options 

Clients can access the aPriori database across a WAN. The aPriori database 
management system can be MySQL, Oracle, or SQL Server. To install and configure the 
server, if your database management system is: 

▪ MySQL – If you purchase a MySQL license through aPriori, aPriori supplies the 
software. Also, you do not need to have prior MySQL experience or expertise 
because aPriori Support fully handles your MySQL installation and configuration. 

▪ Oracle – You must provide the Oracle software and license and a DBA. 

▪ SQL Server – You must provide the Microsoft software and license and a DBA. 

Managing Deployments 

By default, aPriori supports the ability to separate data and easily switch between the 
different data sources. For example, you can have a production deployment that has 
multiple component databases (where part data is stored) and a shared VPE database. 
This allows a company to segregate users and the parts they cost, while maintaining a 
single repository for VPEs that can be accessed by all users. This functionality provides 
a solution to companies that have groups, which do not want to share information or 
must segregate products and components due to regulations such as iTar.  

You can also use the aPriori Access Control functionality to define what users have 
various levels of access to different components.  

Regardless of how you decide to configure your production environment, aPriori strongly 
urges you to maintain both a production installation and a test installation on separate 
servers. Use the test installation to validate upgrades and database migrations, and new 
configurations such as changes to VPEs, Access Control Objects (ACOs), User Defined 
Attributes (UDAs), site variables, etc. Once you are 100% confident of your changes, 
you can roll them over to the production installation. 
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Recommended Standard Deployment 

 

Production Installation – The environment where user day-to-day work is completed 
and saved.  

Test Installation – The environment where Access Control, UDAs, etc. are edited and 
tested. A typical workflow is to export VPEs from the Production Deployment, import into 
the Test Deployment, edit and test in the Test Deployment, and then Import into 
Production Deployment.    

To learn how to install additional deployments, for example for VPE development or 
security, see the aPriori System Administration Guide. 

Note: In earlier versions of aPriori, the recommended structure was for all Production 
and Test deployments using the same version of aPriori to share a license file, 
with only staging servers using a different license file. THIS CONFIGURATION 
IS OBSOLETE AND IS NO LONGER SUPPORTED.  

 For any deployment that you plan to change Access Control, UDAs, etc. in, use a 
different instance of the license than the instance that you use for production 
data. The same license file can be re-used for both installations.  

 If you are upgrading an existing aPriori installation that uses an obsolete, 
unsupported deployment configuration, you must contact aPriori Support for 
assistance with migrating to a newer, supported deployment scheme. 

Advanced deployments 

The previous section provides a high-level overview of a basic aPriori deployment. For 
more information about deployments and more advanced configurations, see the 
"Managing Deployments" section of the aPriori System Administration Guide. 

License 
Schema 

Production 
VPEs 

Production 
Components 

Production 
Deployment 

License 
Schema 

Test 
VPEs 

Test 
Components 

Test Deployment 

Production 
Environment 

Test 
Environment 
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Installing Prerequisite Software 
Prior to installing aPriori, you must install and configure the prerequisite third-party 
components. For installing third-party products, the aPriori Professional Installation 
Guide provides detailed information only for aPriori-specific configurations. Refer to the 
third-party product manufacturer’s documentation for complete installation and setup 
information. 

Prerequisite Database Software 

aPriori requires a database. MySQL Server is available through aPriori. Other supported 
databases include Oracle and Microsoft SQL Server. Check the most recent edition of 
the aPriori System Requirements document for the most up-to-date list of database 
versions that are supported by your version of aPriori.  

 

Database components: Available from 

MySQL Server 5.6 or 5.7 

MySQL Workbench 

One copy is provided by aPriori if purchased 

Oracle 11g or 12c Not provided by aPriori. Contact your Oracle representative. 

Microsoft SQL Server 
2014; or 2016 or 2017 
Standard Edition 

Not provided by aPriori. Contact your Microsoft representative. 

For more information, see "Installing and Configuring a Database". 

Clients 

To generate or modify CAD models, your installation may require a CAD application. For 
example, if you are using aPriori in your design process and running aPriori Professional 
as a CREO® toolkit application, you must purchase and install CREO®. If you are using 
aPriori Professional as a standalone application, you must be purchase and install any 
supported CAD product you plan to use with aPriori. 

Installing a CAD Application 

The Direct Integration mode of aPriori requires Creo® to be installed. For installation 
instructions refer to your CAD Application Installation Guide. 

To use aPriori with Creo® in Direct Integration mode, you must provide the Creo® 
startup directory during aPriori installation.  

Commented [BF12]: Check these versions for 19.2 
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Installing and Configuring a Database 
aPriori supports three database management systems (DBMS): 

▪ MySQL 

▪ Oracle 

▪ Microsoft SQL Server 

For the current supported versions, see the System Requirements document. 

Note: The aPriori solution is typically sold as software plus services. Installation services 
are often included, in which case you do not need to perform the database 
installation on your own. This is particularly true of MySQL installations. Please 
refer to your Statement of Work to understand if this service is included. If so, the 
following sections are for your reference only.  

For information on installing and configuring: 

▪ MySQL – See MySQL Installation and Configuration. 

▪ Oracle – See Oracle Installation and Configuration. 

▪ Microsoft SQL Server – See SQL Server Installation and Configuration. 

MySQL Installation and Configuration 

This section contains information for installing and configuring MySQL on a supported 
Windows operating system. For Linux installation and configuration instructions, see 
Installing MySQL on Linux.  

To create and maintain a MySQL aPriori database you must install these: 

▪ MySQL Server 5.6 or 5.7 

▪ MySQL Workbench 6.3 

Installing MySQL Server on Windows 

aPriori requires that MySQL Server be installed on the server only. The MySQL Server 
installer and license are provided by aPriori and can be found with the aPriori installation 
media.  

To begin MySQL server installation on Windows (MySQL Win Part 1) 

1 Acquire and run mysql-installer-commercial-<version>.msi, the installer 

package for 64-bit servers.  

Note: At the time of publication of this guide, the correct versions for 5.6 and 5.7 
were 5.6.36.0.and 5.7.18.0 respectively. You may be installing a later version of the 
installer package. 

2 Accept the license terms and click Next. 

3 Select your Oracle Support option and click Next.  

4 Select Custom and click Next 

Commented [LC13]: Same info in many places – 
consolidate, single source, link. Change for 2020 R1 
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5 On the next screen expand MySQL Servers and Applications, then move the 
following modules to the Products/Features to Be Installed column. 

• MySQL Server <version> - X64 

• MySQL Workbench <version> -X64 

You do not need any of the “MySQL Connectors” or “Documentation”. Click Next. 

6 If any conflicts are reported, review and correct them, and then click Next. 

7 Click Execute. When the execution is complete, to proceed to the configuration 
steps, click Next  

MySQL Server Configuration screen (MySQL Win Part 2) 

1 On the Type and Networking screen: 

• For Sever Configuration Type select Server Machine from the dropdown 

• The default port number is 3306. Change the number as required. Make sure 
that the Open Firewall port for network access check box is selected. 

• Select the Show Advanced Options check box and then click Next. 

• Determine whether to enable the Enterprise Firewall and select or clear the 
check box accordingly. 

• Click Next. 

2 By default, there is no password on the Accounts and Roles screen. To complete the 
installation, you must set a password for the built in MySQL "root" administrator. Be 
sure to remember the password because you must supply it later in the installation. 
For now, do not create any other users. Click Next. 

3 On the Windows Service screen, the default settings here should be fine. However, if 
you prefer, you can change the name of the service and/or the account under which 
that service runs. Click Next. 

4 (MySQL 5.7 only): If you are presented with a Plugins and Extensions screen, you can 
leave Enable X Protocol/MySQL as a Document Store disabled (unchecked). 
Click Next. 

5 On the Advanced Options screen you should only change the default logging options if 
directed to do so by aPriori Customer Support. Typically, you should accept the 
default logging options, then click Next. 

6 On the Apply Server Configuration screen, click Execute to apply the configuration 
settings. Use the Configuration Steps and Log tabs to monitor progress and 
troubleshoot issues. Once the configuration is done click Finish. 
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MySQL Workbench (MySQL Win Part 3) 

1 When the install is complete, MySQL Workbench should start. If it does not, you can 
start it from the Windows Start menu. 

2 If you changed the path of the data location earlier, you need to edit the connection. 
Right click on the Local instance of MySQL and select edit connection. Click the 
System Profile tab and then replace the path for \my.ini file with the path you 

chose for the data files. Click Close. 

3 Connect to the local instance by clicking on the Local instance MySQL icon. If 
prompted, enter the password that you created for the “root” user. 

4 Click Options File from the list on the left. If prompted, enter your password again. 

5 On the General tab, scroll down and make sure that the default storage engine is 
INNODB and that the character set server is utf8. 

6 Next, go to the Networking tab and change max_allowed_packet to 256M. (Take 

note of this value, particularly if aPriori Customer Support has directed you to use a 
different value. If you are running MYSQL Version 5.6.19 or later, you need it in the 
next step.) 

7 [FOR MYSQL VERSIONS LATER THAN 5.6.19] Open the InnoDB tab and scroll to 
innodb_log_file_size. Ensure that this line is checked and set the value to at least 
six times the value of max_allowed_packet that you set in the previous step. For 
example, for the default max_allowed_packet value of 256M, enter a value of at 

least 1536M for innodb_log_file_size. 

8 On the InnoDB tab, scroll to innodb_buffer_pool_size and ensure that it is set to a 
value at 1G or greater. 

9 In the lower right corner, click Apply. Then, in the popup window, again click Apply. 

10 To create a new schema, select the +schema icon.  

 

11 Name the schema. For single production databases, "apriori" is a typical schema 
name. Click Apply. 

12 Click Apply again and then click Finish. 

13 You can create more schemas as necessary, such as "apriori_test" and 
"apriori_training" for test and training purposes, respectively. 
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Import standarddata.sql (MySQL Win Part4) 

Next, import the standarddata.sql file into your newly created schemas. You can 

download and expand the standarddata.sql file from the aPriori-databases-

<version>.zip file. For more information, see Chapter 1. 

1 In the list on the left, click Data Import/Restore. Alternatively, in the menu bar, 
select Server > Data Import. 

2 Select the Import from Self-Contained File radio button and browse to the 
standarddata<version>.sql file. For example: 

C:\Users\<username>\Downloads\aPriori-databases-<version>\MySQL\ 

standarddata.sql 

Click Open 

3 Specify which schema to import into from the Default Target Schema drop-down 
menu. Click the Start Import button in the bottom right corner. Once it is finished, 
select the Import from Disk tab and repeat the same process for the other schemas 
that were created. 

Create a user and assign privileges (MySQL Win Part 5) 

1 Next create a user and assign privileges: Select Users and Privileges from the list 
on the left or from the Server menu. 

2 Click the Add Account button located on the bottom left. 

3 Enter a Login Name and Password. They can be anything you would like. Confirm 
the password, then click Apply. 

4 Click on the Schema Privileges tab, then click the Add Entry button. 

5 Select the Schemas matching pattern or name radio button. If all the schemas 
start with the same name you can type the beginning and use a wild card. For 
example: apriori% Click OK. 

6 You need to select all the permissions under Object Rights (SELECT, INSERT, 
UPDATE, DELETE, EXECUTE, SHOW VIEW), plus TRIGGER under DDL RIGHTS. 
Select each one and then click Apply. 

You can exit MySQL Workbench. 

FOR ENTERPRISE PLATFORM ONLY - Edit the startup file (MySQL Win Part 6) 

If you are planning to install Enterprise Platform modules such as Cost Insight Report or 
Cost Insight Admin, you must set a system variable in the MySQL startup file to ensure 
that timestamp columns get correctly updated during future upgrades. This system 
variable (named explicit_defaults_for_timestamp) must be set to “1” (or “TRUE”). 

For information about why this setting is necessary, see the MySQL documentation at 
https://dev.mysql.com/doc/refman/5.6/en/server-system-
variables.html#sysvar_explicit_defaults_for_timestamp.  

1 Open Notepad (or your preferred text editor as an Administrator. 

https://dev.mysql.com/doc/refman/5.6/en/server-system-variables.html#sysvar_explicit_defaults_for_timestamp
https://dev.mysql.com/doc/refman/5.6/en/server-system-variables.html#sysvar_explicit_defaults_for_timestamp
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2 Navigate to the MySQL initialization file and open it. (This file is typically 
ProgramData\MySQL\MySQL Server <version>\my.ini If you cannot see the 

ProgramData folder, you need to turn on hidden files in Windows Explorer. 

3 Scroll to the bottom of the file and add these lines: 

# System variable added for aPriori  

explicit_defaults_for_timestamp=1 

4 Save the file. 

Restart the MySQL service (MySQL Win Part 7) 

Finally, stop and restart the MySQL service (MySQL<version>) from Control Panel \ 
Administrative tools \ Services.  

Anti-virus Software Exceptions for MySQL (MySQL Win Part 8) 

We recommend excluding the MySQL data directories from virus scans. In addition to 
the data directory, MySQL uses C:\WINDOWS\Temp when importing and exporting 

databases. This should also be excluded from virus scanning. By default, the MySQL 
data directory is located at: C:\ProgramData\MySQL\MySQL Server <version>\data 

Installing MySQL on Linux  

Important: aPriori requires a case-insensitive database. By default, MySQL on Linux 
is case-sensitive. Keep this in mind if you plan to use an existing Linux MySQL 
database server. To make the server case-insensitive, add the following line to 
the my.cnf file, then restart the MySQL process before importing the data. 

lower-case-table-names=1 

The following sections only apply when using MySQL on a Linux operating system. 
These instructions were written and tested with CentOS version 5.5. The specific Linux 
syntax may vary slightly between versions. These instructions assume the user has a 
general understanding of the specific version of Linux being used.  

There are GUI interfaces for MySQL available on Linux which can also be used. 
Command line instructions are provided since your Linux server may not have a GUI 
installed.  

You need: 

▪ Root (administrative) privileges on the Linux server. 

▪ The MySQL server and client RPM packages for the specific version of Linux on 
which you are installing (provided by aPriori). 

▪ The aPriori database files which contain the aPriori schema (provided by aPriori). 

Note: In this section, where a command is to be typed, it is preceded by either “shell>” 
or “mysql>”. These are command prompts and are not to be typed as part of the 
command. 

MySQL Client Components (MySQL Linux Part 1) 

Run the RPM package that was provided to you by aPriori Support. You may have to 
use the –nodeps and –force options as used in the following command.  
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Note that the names of the RPM files differ slightly from what is shown below depending 
on the version of Linux you are using. 

shell> rpm -i –nodeps –force MySQL-client-advanced-5.6.16-

1.el6.x86_64.rpm 

MySQL Server Components (MySQL Linux Part 2) 

Run the RPM package that was provided to you by aPriori Support. You may have to 
use the –nodeps and –force options as used in the following command. 

shell> rpm -i –nodeps –force MySQL-server-advanced-5.6.16-

1.el6.x86_64.rpm 

The installation should complete on its own and start MySQL. You can verify that it is 
running by typing the following command to see the version information about MySQL. 

shell> mysqladmin version 

Securing MySQL on Linux (MySQL Linux Part 3) 

MySQL has a default administrative user called root. After installing MySQL, the root 
user ID has no password. Follow these steps to set the root password. 

1 Launch mysql 

shell> mysql –u root –p 

2 View accounts 

mysql> SELECT User, Host, Password FROM mysql.user; 

 

3 Use the following steps to allow root access from remote machines. This is an 
optional security setting which allows you to administer the database server from the 
MySQL Administrator GUI on a Windows computer. 

mysql> create user root; 

mysql> grant ALL on *.* to root; 

4 Set the root password. Replace <yourpassword> below with the password you want 

to use. 

mysql> UPDATE mysql.user SET Password = PASSWORD('<yourpassword>') 

WHERE User = 'root'; 

mysql> FLUSH PRIVILEGES; 
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5 Optional: Remove the anonymous accounts. Note, the " ‘’ " just before the " @ " are 

two single quotes, not 1 double quote. 

mysql> DROP USER ‘’@’localhost'; 

mysql> DROP USER ‘’@’localhost.localdomain’;  

Note: The exact host name comes from the table in Step 2. 

6 View accounts again. 

mysql> SELECT user, host, password FROM mysql.user; 

7 Exit MySQL 

mysql> exit 

MySQL Options File in Linux (MySQL Linux Part 4) 

Edit the file /etc/my.cnf: 

1 Go to the /etc directory and type: 

shell> vi my.cnf 

2 Press Alt-I to insert 

3 Move down to the section under [mysqld] and type these two lines 

max_allowed_packet=268436480 

lower-case-table-names=1 

4  [FOR MYSQL VERSIONS LATER THAN 5.6.19] Also add the following line: 

innodb_log_file_size=1610612736 

This value should be set to at least six times the value of max_allowed_packet that 
you set in the previous step.  

5 At the end of the file, append these lines: 

# System variable added for aPriori  

explicit_defaults_for_timestamp=1 

This setting ensures that timestamp columns get correctly updated during future 
upgrades. For information about why this setting is necessary, see the MySQL 
documentation at https://dev.mysql.com/doc/refman/5.6/en/server-system-
variables.html#sysvar_explicit_defaults_for_timestamp.  

6 Press ESC, type ‘:wq’ followed by Enter 

7 Stop MySQL 

shell> mysqladmin -u root –p shutdown 

8 Start MySQL 

shell> mysqld –user=mysql –log & 

https://dev.mysql.com/doc/refman/5.6/en/server-system-variables.html#sysvar_explicit_defaults_for_timestamp
https://dev.mysql.com/doc/refman/5.6/en/server-system-variables.html#sysvar_explicit_defaults_for_timestamp
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Creating the aPriori database and users in Linux (MySQL Linux Part 5) 

1 Start the MySQL client again. 

shell> mysql –u root –p 

2 Create the databases and users 

mysql> CREATE DATABASE apriori; 

(optional) mysql> CREATE DATABASE apriori_test; 

(optional) mysql> CREATE DATABASE apriori_training; 

mysql> CREATE USER apriori IDENTIFIED BY 'apriori'; 

mysql> CREATE USER admin IDENTIFIED BY 'admin'; 

3 The following statements grant the proper privileges to the users. They assign a set 
of privileges to the users ‘apriori’ and ‘admin’ on the databases ‘apriori’, ‘apriori_test’, 
and ‘apriori_training’. The user ‘admin’ has all the privileges as ‘apriori’ plus DROP 
and CREATE. The permissions on all 3 of the databases are the same. 

mysql> GRANT SELECT, INSERT, UPDATE, DELETE, REFERENCES, INDEX, 

ALTER, CREATE TEMPORARY TABLES, LOCK TABLES, CREATE VIEW, SHOW 

VIEW, CREATE ROUTINE, ALTER ROUTINE, EXECUTE  

ON apriori.* 

to apriori; 

mysql> GRANT SELECT, INSERT, UPDATE, DELETE, REFERENCES, INDEX, 

ALTER, CREATE TEMPORARY TABLES, LOCK TABLES, CREATE VIEW, SHOW 

VIEW, CREATE ROUTINE, ALTER ROUTINE, EXECUTE, DROP, CREATE  

ON apriori.* 

to admin; 

(optional) mysql> GRANT SELECT, INSERT, UPDATE, DELETE, REFERENCES, 

INDEX, ALTER, CREATE TEMPORARY TABLES, LOCK TABLES, CREATE VIEW, 

SHOW VIEW, CREATE ROUTINE, ALTER ROUTINE, EXECUTE 

ON apriori_test.* 

to apriori; 

 (optional) mysql> GRANT SELECT, INSERT, UPDATE, DELETE, REFERENCES, 

INDEX, ALTER, CREATE TEMPORARY TABLES, LOCK TABLES, CREATE VIEW, 

SHOW VIEW, CREATE ROUTINE, ALTER ROUTINE, EXECUTE, DROP, CREATE  

ON apriori_test.* 

to admin; 

(optional) mysql> GRANT SELECT, INSERT, UPDATE, DELETE, REFERENCES, 

INDEX, ALTER, CREATE TEMPORARY TABLES, LOCK TABLES, CREATE VIEW, 

SHOW VIEW, CREATE ROUTINE, ALTER ROUTINE, EXECUTE  

ON apriori_training.* 

to apriori; 

(optional) mysql> GRANT SELECT, INSERT, UPDATE, DELETE, REFERENCES, 

INDEX, ALTER, CREATE TEMPORARY TABLES, LOCK TABLES, CREATE VIEW, 

SHOW VIEW, CREATE ROUTINE, ALTER ROUTINE, EXECUTE, DROP, CREATE  

ON apriori_training.* 

to admin; 

mysql> exit 

4 Import the database: 
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• Save the standarddata<version>.sql files on the Linux server. This file is 

contained within the database zip file that was provided with the software 
downloads. 

• Go to the folder containing the database files and type the following 
commands, replacing <version> with the actual version number and 

platform of the file to be imported. 

shell> mysql –u root –p apriori < standarddata<version>.sql 

(optional) shell> mysql –u root –p apriori_test < 

standarddata<version>.sql 

(optional) shell> mysql –u root –p apriori_training < 

standarddata<version>.sql 

Oracle Installation and Configuration 

aPriori requires a MySQL, Oracle, or SQL Server database. This section describes the 
requirements for Oracle database configuration. If you are using MySQL or SQL Server 
instead, please go to either: 

▪ MySQL Installation and Configuration on page 18 

▪ SQL Server Installation and Configuration on page 28 

Oracle configuration should be performed by a certified Oracle Database Administrator. 

NOTE: The aPriori client does not support client-side load balancing via the Oracle Real 
Application Clusters (RAC). If RAC is being implemented on your Oracle 
database, you must specify one particular USER/SCHEMA instance. 

Installing Oracle 

Before beginning Oracle installation and configuration, you should note the following 
information that is required by the aPriori client: 

▪ Names of users, SIDs, service names, and port number are not assumed by the 
aPriori client. This means you are free to provide any values for the Oracle 
database, SID, username, password, etc. Make note of the following information 
because it is required during the installation of the client software: 

• Oracle host name 

• Oracle SID or Service Name 

• Oracle username 

• Oracle password 

▪ aPriori assumes that this user is the owner of the database objects. Therefore, in 
order to use a username to connect which is different from the user who owns 
the database objects (tables and sequences), you must create synonyms which 
point to the actual objects. 

To install and configure Oracle 

You may decide to use an existing Oracle server for aPriori. If you need to install Oracle, 
the following steps outline the installation and configuration used by aPriori Quality 
Assurance for the servers used for certification.  
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Run the Oracle Setup file and during the installation use defaults except: 

▪ In Step 2, choose: Create and configure a database. Specify any database 
name you wish. 

▪ In Step 4: Specify Use Standard Edition, and Change Character Set to 
Unicode AL32UTF8 

Note: aPriori uses Standard Edition for testing and certification, however, since this 
represents a subset of functionality of the Enterprise Edition, that should also 
work.  

Once the installation is complete: 

1 Set the PROCESSES initialization parameter to at least 150 + (5 * number of 
expected concurrent aPriori users) 

2 Create a tablespace with any name you choose. Allocate at least 32Gb of available 
space for up to 100 total aPriori users and an addition 32Gb for each additional 100 
users. Or choose unlimited tablespace.  

3 Create a user with the Default Tablespace you created. This is the user that the 
aPriori client uses to connect to the server and owns the production database objects 
(unless you create synonyms to other user’s objects). Create any name and 
password you wish. This user is  referred to as the master database since it contains 
the user and license information. 

4 Grant the following System Privileges to the user created in the previous step: 

• CREATE SESSION 

• UNLIMITED QUOTA 

5 (Optional) Create another user with the Default Tablespace you created. This user 
owns the database objects for the test deployment. It is recommended that the 
username have the word ‘test’ in it to indicate its purpose. The intent of the test 
deployment is as a safe place to test configuration changes. 

6 Grant the following System Privileges to the user created in the previous step: 

• CREATE SESSION 

• UNLIMITED QUOTA 

7 (Optional) Create another user with the Default Tablespace you created. This user 
owns the database objects for the training deployment. It is recommended that the 
username have the word ‘training’ in it to indicate its purpose. The intent of the 
training deployment is as a safe place to train new users on the software. 

8 Grant the following System Privileges to the user created in the previous step: 

• CREATE SESSION 

• UNLIMITED QUOTA 

9 Configure your server to listen on a public interface 
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To import the Oracle data files 

1 Unzip the file named aPriori_databases_<version>.zip that was provided 

with the installation media. This file contains Oracle datapump dump files that 
can be imported into Oracle 12c or 11g.  

2 Import the file into the user(s) you created in the previous section using the 
Oracle Data Pump Import command impdp. The specific parameters required 
can be found in the readme.txt file also included in the installation media. 

Here are examples of the command. Replace the items in angle brackets ("< >") 

with the actual values and do not include the brackets. Note: This example uses the 
EZ_CONNECT method as opposed to TNSNAMES.ora.  

For Service Name: 

impdp <DBAusername/DBApassword@//hostname:port/serviceName>  

dumpfile=STANDARDDATA<version>.sql 

directory=<your_server_datapump_dir>  

SCHEMAS=APRIORI_DB REMAP_SCHEMA= APRIORI_DB:<your_schema_user>  

REMAP_TABLESPACE= APRIORI_DB:<your_tablespace> 

For SID: 

If you use SID rather than Service Name, change the first line as shown: 

impdp <DBAusername/DBApassword@//hostname:port:SID> 

. 

. 

. 

Additional Oracle information 

▪ If you limit the number of connections to the aPriori database, set the number to 
10 times the number of expected concurrent connections, as each client may 
have up to 10 connections at one time. 

▪ Load balancing – aPriori does not support client-side load balancing currently. 
When installing the aPriori client, you must enter only one host name (or IP 
address). In client-side load balancing, the client application is given multiple IP 
addresses for the host and selects one of them at random when connecting.  

SQL Server Installation and Configuration 

aPriori requires a SQL Server, MySQL, or Oracle database. This section describes the 
requirements for SQL Server database configuration. If you are using Oracle or MySQL 
instead, please go to either: 

▪ MySQL Installation and Configuration on page 18 

▪ Oracle Installation and Configuration on page 26 

SQL Server configuration should be performed by a certified SQL Server Database 
Administrator.  

Installing SQL Server 

Before beginning SQL Server installation and configuration, you should note the 
following information that is required by the aPriori client: 
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Names of users, database instance names, port numbers, etc., are not assumed by the 
aPriori client. This means that you are free to specify values that make sense for your 
location. However, make note of the following information as you define it in the following 
steps, because it is required during the installation of the client software: 

▪ SQL Server host name 

▪ SQL Server port number (typically 1433) 

▪ SQL Server database instance name 

▪ SQL Server authentication style (either "SQL Server" or "Windows") 

▪ SQL Server username for the aPriori database 

▪ SQL Server password 

If you use an existing installation of SQL Server for aPriori, you or a certified SQL Server 
administrator must identify the correct values to specify to the aPriori installation utility. 

If you need to install SQL Server for aPriori, the installation defaults provided during a 
SQL Server installation are generally compatible with aPriori EXCEPT for the details 
specified below. 

To install and configure SQL Server  

Proceed to install SQL Server using the default procedures and values except: 

▪ Specify the 'Mixed mode' authentication option. This setting allows you to use 
both SQL Server and Integrated (Windows) authentication: 

 

▪ Once you have installed SQL Server, to set the TCP port and to define a user 
account, run the SQL Server Configuration Manager: 

3 Bring up the Windows Start menu and in the Search programs and files field, 
start typing: 

SQL Server 2014 Configuration Manager 

10 When the SQL Server 2014 Configuration Manager link appears, click it. 

11 In the resulting window, click the Protocols line under SQL Server Network 
Configuration, then right-click the TCP/IP line in the right column and Enable it. 
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12 Right-click TCP/IP again and click Properties. 

13 Click the IP Addresses tab.  

14 Scroll down to the IPAll section and enter a value for TCP Port. The typical port is 
1433. 

15 Restart SQL Server. 

16 Create an "apriori" login and specify a secure password. You can do so either with 
SQL Server Management Studio (SSMS), or from the command line using the 
following syntax: 

sqlcmd -S "localhost,1433" -d master -Q "CREATE LOGIN apriori WITH  

PASSWORD='< apriori_db_password >' 

Notes:  

• This command assumes that your Windows user account was included as a 
SQL Server administrator during the install. If the account is not an SQL 
Server admin, add: -U sa -P <password>  

• SQL Server distinguishes between Logins and Users. Logins are associated 
with the Server; User are associated with individual Databases. Logins get 
mapped to Users. When aPriori requires a database username in order to 
establish a connection to the database it needs the Login name. 

To create a SQL Server database instance 

You should create an SQL Server database instance for the aPriori Client before you 
install aPriori Professional. This section shows how to create a database instance. If you 
plan to use more than one version of aPriori, each should use a separate database 
instance. If the client is intended to connect to an existing database instance, skip this 
step.  

17 Create a database, ensuring the Is Read Committed Snapshot On option is 
enabled. 

Note: You might experience hangs or deadlocks if this option is not enabled.  

You can enable this option from the command line as shown below. You can also 
use SQL Server Management Studio (SSMS) if you prefer.  
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sqlcmd -S "localhost,1433" -d master -Q "CREATE DATABASE 

[apriori_db]; ALTER DATABASE [apriori_db] SET 

READ_COMMITTED_SNAPSHOT ON; ALTER DATABASE [apriori_db] SET 

AUTO_CLOSE OFF; ALTER AUTHORIZATION ON DATABASE::[apriori_db] TO 

apriori" 

Notes: 

• This example creates a database named apriori_db. You can specify 
whatever name you like, but you must ensure that it is used consistently 
wherever the database is referenced. 

• This configures the 'apriori' user (created earlier) as the database's owner. If 
you plan to do everything using your Windows user account, you can omit the 
'ALTER AUTHORIZATION' clause. 

• The SQL shown also disables the auto-close feature. This is typically 
disabled by default but could be enabled in some versions of SQL Server. 
(The auto-close feature closes the database and releases some resources 
when there are no users connected. In a production environment, closing the 
database has little value and typically degrades performance for the next 
connection.) 

18 Ensure that the Collation setting under Options is set to 
SQL_Latin1_General_CP1_CI_AS 

 

Notes: 
– Collations that have either “_CS_” or _BIN in their name 
prevents aPriori from working correctly. aPriori has table names 

https://confluence.apriori.com/pages/viewpage.action?pageId=15336243#DesignNote:MSSQLServerinstall&config-autoclose
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such as “fbc_ComponentState”) that have uppercase letters in 
their name, but which get called from within aPriori as all 
lowercase (e.g., “fbc_componentstate”). A database with a CI 
(case insensitive) collation ignores the difference, while a 
database with CS (case sensitive) or BIN (binary comparison) fails 
to open the table in request. 
 
– Non-USA installations may be able to substitute other suitable 
collation settings as documented on this Microsoft page: 
https://msdn.microsoft.com/en-
us/library/ms143508(v=sql.105).aspx  

19 Import the aPriori standarddata<version>.sql file into the newly created 

database, using the following command line (replacing <version> with the actual 

platform and version suffix to the file name): 

sqlcmd -S "localhost,1433" -U apriori -P <apriori_db_password> -d 

apriori_db  

-i standarddata<version>.sql 

Notes:  

• This assumes that you are using the apriori user created earlier. The -U and 

-P parameters can be omitted if you instead use your Windows account. 

• Several warning messages of the form appear: 

"Warning! The maximum key length is 900 bytes."  

These can be ignored. The client includes runtime checks to avoid exceeding 
SQL Server's maximum key length. 

• However, there is a limit of 404 characters on the combined length of the 
component and scenario names. Any attempt to save or migrate a 
component that exceeds this limit fails with an error messages similar to: 

"The scenario name is too long. The combined length of the 

component and scenario names must not exceed 404 

characters..." 

If you encounter such a message when using aPriori, you must rename the 
problematic scenario.  

aPriori Client Installation Adjustments 

When you install the aPriori Client (see Installing the aPriori Professional Client) after 
installing SQL Server, make the following adjustments: 

At the Database Schema Configuration panel, select SQL Server and fill in the fields 
reflecting the values used in the database configuration above. 

Note the option to choose either 'SQL Server' or Windows Authentication 
("Integrated/Native Authentication"). In the latter case, the username and password 
fields are redundant and are therefore disabled. 

Notes:  

• In the SQL Server environment, the Database Schema Name field changes 
to Database Instance Name. Schemas are distinct from database instances 

https://msdn.microsoft.com/en-us/library/ms143508(v=sql.105).aspx
https://msdn.microsoft.com/en-us/library/ms143508(v=sql.105).aspx
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in SQL Server. aPriori uses the database user’s default schema, typically 
‘dbo’. Distinct database instances are used in cases where distinct schemas 
would be used with MySQL or Oracle. 

• If you select SQL Server Authentication, the username field requires the 
login name created earlier (for example, enter apriori if the earlier command 
line example was used exactly as shown).  

20 Complete the install as directed in the installation chapter. 

A Note About Deleting SQL Server Databases 

You may find that attempts to delete SQL Server databases fail or time-out due to 
connections having been left open. This is easily solved: 

▪ When deleting a database from SQL Server Management Studio, check the 
Close existing connections' option: 

 

▪ When deleting a database from the command line, set the database into 'single 
user' mode to kill off any other connections: 

sqlcmd -S "localhost,1433" -d master -Q "ALTER DATABASE [apriori_db] 

SET SINGLE_USER WITH ROLLBACK IMMEDIATE; DROP DATABASE 

[apriori_db]" 
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Installing the aPriori Professional Client 

Before You Begin 

Before you begin installing aPriori Professional: 

▪ Install all the prerequisite software. For more information, see Installing 
Prerequisite Software. 

▪ Create the aPriori database. Make sure that each client machine has access to 
the aPriori database.  

▪ Have ready the information that you need to enter during the installation: 

• Installation directory. By default, aPriori is installed to C:\aPriori. 

• Components that need to be installed 

• Document cache location 

• Host name, port number, schema name, username, and password for the 
aPriori database. In addition, if aPriori is using an Oracle database, you need 
to know either the SID or the Service Name. If the database is SQL Server, 
determine whether you use SQL Server or Windows authentication. 

• For Direct Integration mode only, the CAD application startup directory where 
your local Creo config.pro file is located. 

• Any aPriori properties or Bulk Costing properties that you want to set. 

• Installation type. The type of installation–whether the installation is a fresh 
install, or an upgrade or “hot fix” to an existing installation–determines 
whether you need to tell the Wizard how to back up existing files. 

Install by Using the aPriori 
Professional Setup Wizard 
The on-premise installation of aPriori Professional 2019 R2 introduces a new installation 
Setup Wizard. The new Setup Wizard: 

• Automates much more of the installation process than is automated by the 
wizard for prior releases. 

• Displays existing or default values for many configuration settings and allows you 
to review and modify values during the installation process. 

• Allows you to access context-sensitive information for each step in the 
installation process. To access the information, click Help. 

Notes about keyboard behavior 

▪ Using TAB to navigate to a button or a checkbox and then pressing Enter does 
not always execute the target, even if it is highlighted. The Space Bar sometimes 
work in this situation. 

▪ To expand/collapse nested items from the keyboard, use the numeric keypad “+” 
and “-” keys. 
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Open the aPriori Professional Setup Wizard 

1 Navigate to the directory that you extracted the Wizard from the .zip file to. 

 

2 Double-click the installer executable file, apriori-setup.exe. 

3 Depending on your operating system and any installed virus protection, you may 
receive one or more executable permission requests or warnings. To permit the 
Setup Wizard to run on your system, click through requests and warnings. 

Note: At each stage of the installation setup, the window that appears and the 
information that it contains both depend on the configuration choices that you make 
during the setup process. 

Welcome screen 

 
The Setup Wizard guides you through the installation of aPriori Version 2019 R2 Build 
XXXXX.  

During the installation, the Setup Wizard creates and populates these initialization (.ini) 

and configuration (.properties) files in the top level of the installation directory: 

▪ aPriori-install-options.ini – Records all the values you set during the 

installation (except properties) and can help you perform subsequent installations 
or re-installs. 
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▪ apriori.properties – Records any properties that you specify during the 

installation. 

To allow the Setup Wizard to create and update the initialization and properties files 
without rebooting your computer, close other applications before proceeding with the 
installation. 

To begin the installation process, press Next. To instead exit Setup, click Cancel. 

License Agreement 
 

 

The License Agreement window allows you to review the terms for installing and using 
aPriori Professional.  

After reading the agreement, to further research any issues, concerns, or questions that 
remain, select I Disagree and then click Cancel.  

If you agree with the terms, to proceed with the installation, select I Agree and then click 
Next. 

Select Destination Directory 
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The Setup Wizard allows you to select the destination directory for the aPriori 
Professional installation. The Wizard also lists the version and location of any prior 
installations, which it identifies by examining your environment. The directory for each 
prior installation includes the initialization (.ini) settings file for that installation. 

 

For the new installation, you can: 

• Use a preloaded initialization file.  

• Create a new initialization file based on values that you specify during the 
installation. 

• Use the initialization file from a prior installation. 

 

1 Enter, or Browse to, the directory where you want the new installation to reside. 

2 To use: 

a. A preloaded initialization file or to create a new initialization file based on 
values that you specify during the installation, click Next 

b. An initialization file from a prior installation, select the Use Previous 
Installation Settings check box, select the prior installation from the list, 
and click Next. 
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The Setup Wizard searches the destination directory that you specify. If the destination 
directory does not yet exist, the Setup Wizard asks if you want to create it. To: 

• Give the Setup Wizard permission to create the directory, click Yes. If you cancel 
the installation before it is complete, the Setup Wizard does not create a new 
directory. 

• Deny permission and then enter or browse for a different destination directory, 
click No. 

 

Alternatively, if the destination directory already exists, the Setup Wizard then 
determines if the directory is empty. If the directory is: 

• Empty, the installation proceeds.  

• Not empty, the Setup Wizard asks how you want to proceed.  

 

 

The options are:  

• Change directory – The Setup Wizard allows you to enter or browse for a new 
installation directory. Again, if you enter a name for a new directory, but cancel 
the installation before it is complete, the installer does not create the new 
directory. 

• Clean and continue – The Setup Wizard deletes the directory folder and all the 
content of the directory without making a backup. If you choose this option, 
before the installation begins, the Setup Wizard warns you once that it is about to 
delete the directory folder and all the content therein. Once the installation 
begins, you cannot cancel the deletion of the files. 

• Backup and continue – The Setup Wizard makes a backup copy of the existing 
directory.  The naming convention for the root folder is appended to contain the 
version number of the directory that is backed up: aPriori_Old_bckup_2019 R1 

SP2_89131.  

• If you cancel the installation before it is complete, the Setup Wizard does not 
create a backup copy. 
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Select Components 
 

 

In the Select Components window, the Setup Wizard allows you to select which 
components are installed and to use an advanced installation mode. You can expand 
each component category node to select or deselect individual components for 
installation. 

Although you cannot opt out of the aPriori Client installation, you can choose whether to 
install components from these three categories: 

▪ Direct CAD Integrations – Select this option if you plan to use aPriori as a 
Creo® toolkit application.  

The direct CAD integrations component is Creo & Pro/ENGINEER 

▪ aPriori Cost Connectors – Select the cost connector CAD format that matches 
the types of files that you intend to cost. If you do not intend to use aPriori as a 
toolkit application, always select the option for STEP/IGES in addition to the 
proprietary CAD system you use.  

The aPriori cost connector components are: 

o Creo & Pro/ENGINEER 

o CATIA V5 

o Unigraphics NX 

o SolidWorks 
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o Parasolids 

o Autodesk Inventor 

o STEP/IGES 

o Solid Edge 

o JT  

▪ Required Libraries – aPriori Professional functions properly only if all the 
components in the required libraries folder are installed. If you want to decrease 
installation time, you can check to see if any of the components are already 
installed and then clear the check boxes for those components. However, it 
typically takes more time to determine if you have a component already installed 
than it does to have the aPriori Professional installer reinstall the component. 

The required library components are: 

o Microsoft VC++ 2010 Runtime 

o Microsoft VC++ 2012 Runtime 

o Microsoft VC++ 2013 Runtime 

o Microsoft VC++ 2015 Runtime 

o Dassault VC10 Prerequisites 

o Dassault VC11 Prerequisites 

If you are unsure about what to install, select all the components. Installing all the 
components requires additional installation time and disk space, but it ensures that 
everything that is required for aPriori to function properly is installed.  

The Setup Wizard calculates and displays how much disk space is required for the 
installation of all the components. It also displays how much free space there is on the 
disk that contains the installation directory. 

To specify aPriori and Bulk Costing properties later in the installation, select the Use 
advanced installation mode check box. 

After you make your choices for the component and advanced mode installation options, 
to continue the installation, click Next. 
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Document Cache Configuration 

 

 

Document Cache – To improve aPriori performance, save a local version of your VPE 
data in a cache folder.  

Saving VPE data locally eliminates the need to extract large amounts of data from the 
database each time a part is costed. Extracting large amounts of data from the database 
can diminish performance, especially when the clients and the database server are in 
different LANs. 

You can specify the location of the document cache folder during client installation; 
choose one of these three options: 

▪ User Profile – The cache location is the home directory of the user, typically 
C:\Users\<username>\appdata\local\apriori. This option is the default.  

▪ aPriori Installation Directory – Select this location to place the cache in the 
same folder as all the aPriori application files. Before you select this option, make 
sure that the user has write permission to that location.  

Note: By default, in Windows 7 and later, users do not have write permission to 
the ‘Program Files' folder. 

▪ Custom – Enter or browse for a custom location for the document cache 
directory. If you install aPriori locally on each computer, but want users to share a 
common cache location, use this option. The cache location should be a network 
share that is located within the same LAN as the users. 

If you choose this option, only a single cache location requires updating when 
VPEs are updated. However, during costing, each user could experience slightly 
lower performance because the data pull is across a network. 
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Note: The user must have read/write access to the document cache directory. 
Therefore, if you select a network location or the Program Files directory on the 
local computer, the Windows folder permissions must be set to allow read/write 
permission. 

By default, the installer enables the document cache cleaner. Disable this option only if 
you set up a shared document cache and automate the updating of the document cache. 
To disable the option, clear the Enable Document Cache Cleaner check box. 

To automate the updating of the document cache, run the updateDocCache.cmd script 
in the aPriori\bin\ directory. Before running the script, edit it and add the aPriori user 

ID and a password. You can set up the script to be run by a Windows Scheduled Task 
on a periodic basis. 

Database Schema Configuration 

 

The figure shows the configuration fields for a MySQL database. The configurations for 
Oracle and SQL Server databases include some different fields. 

 

The fields that are included on this dialog depend on the database management system 
you specify. Select one of the Database options, MySQL, Oracle, or SQL Server, and 
then enter values in the related fields. 

MySQL– Refer to MySQL Installation and Configuration. 

• Host Name – Name of the server where MySQL is installed and hosts the 
database. 
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• Port Number – The default value is 3306. Change the value to something 
different only if you changed it during the MySQL installation. 

• Database Schema Name – Name specified during the creation of the 
database schema. The typical value is apriori. Variations on the typical 

value also include software and company information such as version, 
geographic location, or division. 

• Database Username – Username specified during the creation of the 
database schema.  

• Database Password – Password specified during the creation of the 
database schema. 

Oracle – Refer to Oracle Installation and Configuration or see your database 
administrator. 

• URL Style Name – Select either SID or Service Name. 

• Host Name – Name of the server where Oracle is installed and hosts the 
database. 

• Port Number – this is typically 1521 

• Database SID/Service Name –SID or service name of your database 

• Database Username – enter the username of the aPriori database as 
configured by your database administrator 

• Database Password – enter the password of the aPriori database as 
configured by your database administrator 

SQL Server – Refer to SQL Server Installation and Configuration or see your 
database administrator. 

• Host Name – This is the name of the server where SQL Server was installed 
and hosts the database. 

• Port Number – this is typically 1433 

• Database Instance Name – enter name of your database as configured in 
the SQL Server chapter 

• Authentication Style – Select SQL Server or Windows, as configured in 
the SQL Server chapter 

• Database Username – enter the username for the aPriori database as 
configured by your database administrator 

• Database Password – enter the password for the aPriori database as 
configured by your database administrator 

• Click Next when done. 

Schema Verification 

When you click Next, the Installer tries to connect to the schema that you specified. If 
the connection fails, this error is generated: 

Could not create JDBC connection: 

The second half of the message contains specific details about the failure. Some 
common errors and solutions are: 
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Error Solution 

The TCP/IP connection to the host xxx, 
port yyy has failed 

Verify that the specified Database type is 
correct. Also ensure that is available and 
accessible through your firewall 

 
The Network Adapter could not 
establish the connection 

Communications link failure 

 

Verify that the specified Host Name and 
Port Number are correct. 
Check that your Internet connection is up. 

 

Unknown database "xxxx": 

 

Verify that the specified Database 
Schema Name is correct. 

 

Access denied for user "nnn@mmm" 
(using password: YES) 

 

Verify that the specified Database 
Username is correct. Also verify that the 
specified values in the Password fields 
are correct and equal. 

 

 

Oracle ONLY – SID vs. Service Name 

The Wizard accepts either Oracle SID or Service Name on this window. 

SQL Server ONLY – Authentication Style 

Enterprise Platform supports two kinds of authentication: 

▪ SQL Server Authentication 

▪ Windows authentication 

When Windows is selected, the credentials fields are disabled because they are only 
required for SQL Server authentication style. 
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Memory Configuration  

 

The Memory Configuration settings allow you to specify the maximum amount of 
machine memory in the run stand-alone file to dedicate to the Java heap space.  

 

The minimum setting is 4 GB. A typical setting is between 4 GB and 8 GB. A default 
setting of more than 4 GB indicates that, for this installation, you are using a setting from 
a either a preloaded initialization (.ini) file or a previous installation. 

The installer calculates and sets the maximum amount that you can specify as 

𝑋𝑚𝑥𝑚𝑎𝑥 = 𝑋𝑚𝑥𝑡𝑜𝑡𝑎𝑙 − 2 𝐺𝐵 

Where: 

• Xmxmax is the maximum dedicated heap space, in GB. 

• XmxTotal is the total available heap space, in GB. 

To change the maximum amount of machine memory to devote to the Java heap space, 
adjust the position of the slider. To adjust the value incrementally by ±0.01 GB, drag the 
knob to the right or left. To adjust the value by a factor of ±50 GB, first click the Memory 
Configuration window and then use the arrows on your keyboard to move the knob. 

Caution: Assigning too much memory to heap can disable your machineHeap. On the 
other hand, if Java requires more memory than you specify, a memory error is 
generated. 

Commented [SS33]: should this be here? 

Commented [LC34R33]: Yes. 

Commented [SS35]: GB for consistency 

Commented [36]:  



First-Time Installations  aPriori Installation Guide 

aPriori Professional (On-Premise) 
Version 2019 R2  aPriori Confidential 46 

For a complete discussion of aPriori Professional heap size requirements, see Chapter 
9, Adjusting Heap Memory in the 2019 R2 (or later) aPriori Professional System 
Administration Guide. 
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Creo and Pro/ENGINEER Configuration   
 

  

 

Enter, or Browse for, the PTC Creo startup directory on your machine. Then, select the 
version that matches the installed Creo software. 

 

To determine the location of the directory, in Creo: 

1. Select File > Help > System Information. 

2. Scroll to the Installation Directories and Command Information > Directories section. 

3. The startup directory is listed as the Creo Parametric Startup Directory. 

 

To determine the version number, in Creo: 

1. Select File > Help > System Information. 

2. Scroll to the License Information section. The version number is listed as the 
Version. 
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aPriori Properties Configuration   
 

 

 

 

The setup wizard displays the aPriori Properties Configuration settings window only in 
the advanced installation mode. To enable the advanced mode, navigate back to the 
Select Components window and select the Use advanced installation mode check box.  

Selecting the advanced installation mode also allows you to specify Bulk Costing and 
Analysis Plugin properties later in the installation. 

Any properties that appear when this configuration window first opens are properties that 
the setup wizard obtained from a preloaded initialization (.ini) file or a previous 
installation. Although you can replace the value of a preset property in the configuration 
field, the preset value takes precedence over the value that you replace it with if the 
preset value is already saved to the database. 

Properties that you specify are added to the aPriori.properties file in the installation 
directory. 

Specified properties that are not already defined in the database are saved to the 
database once aPriori Professional is started,  

Note: Properties that are saved in the database always take precedence. Therefore, if 
you are upgrading or re-installing an installation where 
apriori.initial.scenario.name (for example) is already set equal to “start” 

and has been saved to the database, specifying a new value on this screen (or in 
the apriori.properties file) have no effect. 

To remove a property, select the adjacent check box and click Remove. 
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To add a property and specify its value: 

1. Click the Add button.   

2. Highlight and click the property that you want to add from the menu of customer-
definable properties that appears. 

3. Specify a value for the property in the field on the right. 

 

For each property that you want to specify, repeat the process. In all, there are 17 
properties that you can specify. If you add all 16 properties, the Add button is disabled. 

 

• apriori.initital.scenario.name 

• apriori.keep.free.bodies 

• apriori.show.multibody.options 

• apriori.enable.surface.models 

• apriori.disable.doc.cache.sync.on.start.up 

• apriori.useOfficialScenarioInNewAssemblies 

• apriori.show.english.units 

• prod.info.default.pg 

• apriori.info.default.vpe 

• apriori.info.default.material 

• apriori.info.default.material.catalog.name 

• apriori.info.default.annual.volume 

• apriori.info.default.production.life 

• apriori.info.default.batch.size 

• apriori.info.default.use.vpe.for.all.processes 

• cost.table.decimal.places 

• viewer.driver 

 

For more information about aPriori Properties, see Chapter 10, “Properties Files”, in the 
aPriori Professional System Administration Guide. 
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Bulk Costing Plug-In Properties 
Configuration  
 

 

 

The setup wizard displays the Bulk Costing and Analysis Plugin Properties Configuration 
settings only in the advanced installation mode. To enable the advanced mode, navigate 
back to the Select Components window and select the Use advanced installation mode 
check box.  

Selecting the advanced installation mode also allows you to specify aPriori properties 
earlier in the installation. 

Any properties that appear when this configuration window first opens are properties that 
the setup wizard obtained from a preloaded initialization (.ini) file or a previous 
installation. Although you can replace the value of a preset property in the configuration 
field, the preset value takes precedence over the value that you replace it with if the 
preset value is already saved to the database. 

Properties that you specify are inserted into the Bulk Costing properties file, which is 
typically located at: 

C:\aPriori2\ext\analysis-purchasing-module\plugin.properties 

To remove a property, select the adjacent check box and click Remove. 

To add a property and specify its value: 

4. Click the Add button.   

5. Highlight and click the property that you want to add from the menu of customer-
definable properties that appears. 

6. Specify a value for the property in the field on the right. 
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For each property that you want to specify, repeat the process. In all, there are 30 
properties that you can specify. If you add all 25 properties, the Add button is disabled. 

The properties that you can specify are: 

• bulkloader.adjust.cattemp.dir 

• bulkloader.batch.name 

• bulkload.clear.existing.inputs 

• bulkload.ignore.validation.errors 

• launcher.debug.mode 

• launcher.debug.port 

• launcher.debug.suspend 

• launcher.max.memory 

• launcher.log4j.configuration 

• launcher.logs.dir 

• launcher.configure.p_schema 

• launcher.cost.timeout.seconds 

• launcher.filter.perfomance.logs 

• launcher.jvmArgs 

• bulkload.concurrent.loader.count 

• bulkload.rmi.port 

• launcher.set.apriori.cad.disable.plastic.molding.thickness 

• launcher.set.apriori.cad.id.persistency.AcisEngine.CATIA 

• launcher.set.apriori.enable.surface.models 

• launcher.set.apriori.keep.free.bodies. 

• launcher.set.apriori.cost.free.bodies.as.assembly 

• launcher.set.apriori.enable.doc.cache.cleaner 

• bulkload.batch.size 

• launcher.costlogger.file 

• launcher.costlogger.class 

• bulkload.defaultWatchpointFile 

• cost.report.flush.soft.scenarios 

• apriori.dateonlypattern 

• launcher.set.apriori.force.suppress.hoops.dialogs 

• bulkload.readCadProperties 
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For more information about Bulk Costing properties, see Chapter 10, “Properties Files”, 
in the aPriori Professional System Administration Guide. 

 

 

About to Install 

 

The setup wizard alerts you that the installation is about to begin and lists the 
components that it is going to install.  

To add or remove installation components, navigate back to the Select Components 
window and select or clear the checkbox for the relevant components. 

To start the installation, click Next. 

After you click next, if you are installing to a: 

• New directory – You can cancel the installation while it is in progress 

• Preexisting directory that you chose to backup – You can cancel the installation 
while it is in progress, but the installer does not backup the file. 

• Preexisting directory that you chose to clean – Before the installation begins, the 
Setup Wizard warns you that it is about to delete the directory folder and all the 
content therein. If you choose to proceed, once the installation is in progress, you 
cannot cancel the installation or the deletion of the files. 
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Installation in Progress 

 

 

During the installation, the progress bar shows the approximate pace and state of the 
installation. 

To stop the installation while it is in progress, click Cancel. 

Warning: If you are installing to a preexisting directory that you chose to Clean and 
continue, you cannot cancel the deletion of the directory files or the installation of 
aPriori Professional while it is in progress.  
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Installation Done 

  

 

The Setup Wizard alerts you when the installation is complete. 

To add a shortcut for aPriori Professional to your computer desktop, select the Create 
Desktop Shortcut checkbox. 

To finalize the installation process and exit the Setup Wizard, click Finish. 

 

Faster subsequent installations 

During the installation, the initialization file is placed in the installation folder. The file is 
named aPriori-install-options.ini and it contains all the inputs from the 

installation. 

To make future installations faster and easier, place the initialization file in the folder that 
contains the apriori-setup.exe file. Then, during the next installation, all the inputs 

are pre-populated for each Setup Wizard window and the user just has to click Next to 
proceed through the installation. 

The initialization file can also be used to install from a command line. For more 
information, see Silent Client Install. 
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Uninstalling 
To uninstall aPriori Professional, you can use <apriori_install>\uninstall.exe: 

Uninstaller Welcome screen 

 

Click Next to start the uninstallation. 

Alternatively, you can choose to use Windows Add/Remove Programs from the Control 
Panel. After doing so, ensure that all the files are removed. If any are not, delete them 
manually. 
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Uninstall in Progress 

 

The progress bar shows you where the status of the uninstallation process.  
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Uninstall Done 

 

This screen appears when the uninstaller is done. Click Finish to delete any remaining 
files and close the installer.  

More on File Permissions 
Sometimes the permissions set at the aPriori installation folder level do not get applied 
to the files in the folder. aPriori does not run (in CAD-I or direct integration mode) if the 
logged in user does not have read and execute permission to the files in the folder. You 
can test this by opening the hibernate.properties file in the aPriori installed directory.  If 
you cannot open the file, follow these steps to force the files within the directory to have 
the same permissions as the top-level directory: 

1 Open the properties for the folder and click the Security tab.   

2 Add or select a group which contains the users who need to run the application. 

3 The default permissions are sufficient: Read & Execute, List folder Contents, and 
Read.  

4 Click Advanced.  

5 Check the box next to "Replace permission entries on all child..." and make sure 
the box is checked next to "Inherit from parent the permission entries..."  

6 Click OK  

7 Click Yes  
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8 Check that you can open the hibernate.properties files from the client. 

Silent Client Install 
aPriori can be installed without user interaction. This is done by installing once using the 
normal interactive installer. This creates a configuration file which can then be used as 
the input to the silent install. 

To install aPriori without user interaction: 

1 Install aPriori the first time using the interactive installer as described at Installing the 
aPriori Professional Client. When it is finished, a file named aPriori-install-

options.ini is present in the aPriori installation folder. This file contains the 

configuration options required by the silent installer. 

2 Copy apriori-setup.exe, and aPriori-install-options.ini to a file share that 

can be accessed from the client machines on which aPriori is being installed. 

• apriori-setup.exe is the same file that you used to install aPriori on the 

first machine. 

• aPriori-install-options.ini is the file created at the top level of the 

aPriori installation directory on the server machine during aPriori installation. 

3 Open a command window and cd to the file share where you have copied the files. 

Run the installer from the command line (or a batch script) with the following syntax:  

apriori-setup.exe -q  

The “-q” specifies that the installer should run in “quiet” mode and take its values 
from the .ini rather than by prompting the user interactively. 

NOTE: The syntax for this command is different from the syntax for the same 
command for the installation of version 2019 R1 SP2 and earlier versions of aPriori 
Professional. 

Here are some other parameters that you can specify for debugging purposes and to 
generate a log file: 

-Dinstall4j.detailStdout=true  

-Dinstall4j.debug=true                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                           

-Dinstall4j.keepLog=true 

When installation is complete, start aPriori on each machine. For details, refer to 
Configuring and Starting aPriori.               
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Configuring and Starting aPriori 
This chapter includes the following topics: 

▪ Load the License File 

▪ Add aPriori User Accounts 

▪ Starting the CAD-Independent Client 

▪ Starting the Direct Integration Client 

▪ Configuring the Test and Training Databases 

Load the License File 

You should have received a license file along with the installation media. License files 
typically follow the naming convention: aPrioriLicense_YYYMMDD_customer name.apz  

▪ Some web browsers change the file extension of the license file from .apz to .zip. 
If this happens you can leave the extension as .zip. 

▪ When you load the license, you must also create the first user. 

▪ The command is case sensitive 

▪ Put quotes around any parameters that have a space in them 

To load the license: 

1 Open a command prompt at the \bin directory in your aPriori installation folder. 

2 Type the command loadlicense.cmd and press enter. This command shows you the 
help for the command. 

3 Type the following command and press enter: 

loadlicense.cmd -DlicenseFile=<license_file_full_path> -

DlicenseUsername=<first_user_acct> -

DlicenseFullname=<first_user_name>  

-DlicensePassword=<first_user_passwd> 

For example, to load a license file named "aPrioriLicense_20130501_acme.apz" 
located at  
C:\aPriori, and your full name is "John Doe" with a username of johndoe with a 

password of 987XYZ!, the correct command is: 

loadlicense.cmd –

DlicenseFile=C:\aPriori\aPrioriLicense_20130501_acme.apz  

-DlicenseUsername=johndoe -DlicenseFullname=”John Doe” 

-DlicensePassword=987XYZ! 

Note: As usual with the Windows command line, don’t forget to enclose in double 
quotes any paths or arguments that include spaces. 
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Add aPriori User Accounts 

User accounts must be added before users can start using the system. Refer to the 
aPriori Administration Guide for details about adding additional aPriori user accounts. 

Starting the CAD-Independent Client 

To start the CAD-independent Client, you can either: 

• Double-click the aPriori Standalone icon on your computer desktop: ( ).  
(The aPriori Standalone icon appears only if you added it to your desktop 
during the installation.) 

• Execute the command file: 

C:\aPriori_Installation_Directory\bin\runStandaloneApriori.cmd 

Starting the Direct Integration Client 

Typically, you start the Direct Integration Client directly through the CAD system. When 
you open the CAD system, aPriori starts as the Cost Ticker in Direct Integration mode. If 
prompted, enter your aPriori username and password.  

To expand to aPriori Desktop 

In aPriori Cost Ticker, click Switch to full view button at the left of the menu bar: 

  

To manually disconnect from the CAD system: 

Within aPriori, click the "connected" status icon:  . 

To manually connect to the CAD system: 

Within aPriori, click "disconnected" status icon: . 

Configuring the Test and Training Databases 

The following steps need to be performed only once: 

1 From the aPriori client click Tools > System Admin Toolset. 

2 Click the System Administrator button: 
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3 Click Deployment – Default in the navigation pane: 

  

4 In the Deployment Name field, change "Default" to "Production". 

5 Click File > Create Deployment. 

6 In the Deployment Name field enter "Test". 

7 In the VPE Schema Name field enter "Test VPE". 

8 Uncheck the VPE Schema Inherits from Master checkbox. 

9 In the VPE Schema Database Identifier field change the existing value to 
"apriori_test". 

10 In the Component Schema Name field enter "Test Scenarios". 

11 Uncheck the Component Schema Inherits from Master checkbox. 

12 In the Component Schema Database Identifier field change the existing value to 
"apriori_test". 

13 Repeat the above process to create a deployment for training, replacing all instances 
of “test” with “training”. 

14 When done, click the Publish Changes button in the toolbar: 
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Installing the CAD Plugin  
The “Cost in aPriori” plug-in for CATIA®, SolidWorks®, and NX® allows users to cost a 
component in aPriori by clicking a toolbar button within the CAD application. This option 
is licensed separately, and therefore you only receive the installation files if you 
purchased this option.  

Note: aPriori does not ship the plug-in for NX. A Professional Services engagement is 
required in order to create the NX plug-in installer. Please contact your aPriori 
Services representative. 

Pre-requisites 

▪ CATIA, SolidWorks, or NX must already be installed on the computer. 

▪ You must have Administrative rights on the computer. 

▪ If you are using NX: 

o You must attain the installer files from your aPriori Services 
representative. 

o You must verify that your device drivers are compatible. 

NOTE  If your devices drivers are not compatible, functionality is diminished, as 
generated error messages indicated. As a temporary workaround, to complete a 
process that generates an error that is related to incompatible device drivers, you 
can temporarily disable the incompatible device. 

Installation 

1 Launch the MSI installer that matches the CAD system and version. For example, if 
you are running SolidWorks 2012 on a 64-bit computer, you would launch 
CostInAPriori_for_SW2012_Installer_x64.msi.  

Note that the files designated “CATIA_V5R21” are also for CATIA V5 R20. 

2 Click Next at the welcome screen. 

3 For SolidWorks and NX, select the location where you want to install the plug-in. 

For CATIA, the plug-in is installed directly in the CATIA installation folder. 

Browse for and select the location of the aPriori installation folder and click Next. 
You must specify the correct location of the aPriori installation folder, or the plug-in 
will not function. 

4 Click Install. 

5 Once the installation is complete, click Finish. 

After installing, there is a new toolbar button with the aPriori logo. In CATIA, you may 
need to enable the button from the View -> Toolbars menu option. 
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Editing the Configuration 

If the location of your aPriori installation changes, you need to update the plug-in to point 
to the new location. You can do this by selecting Cost in aPriori > Options from the 
toolbar of your CAD application. In CATIA this is in the Tools menu. 

You can also edit the aPriori installation location by editing the properties file. The 
location of this file depends on your operating system. For example, for Windows 7, the 
location is: 

<user_home>\AppData\Local\aPriori  

where <user_home> is typically C:\users\<username> 

This file is named costinapriori<CAD_system_name>.properties. For example, if 

you are using SolidWorks, it is named costinapriorisolidworks.properties. 

Important: Performance is slow if the <user_home> directory is a network drive. Edit the 

properties file above to specify a temp location on the local hard drive. 

Silent Installation 

Since the installer is an MSI package, you can use msiexec to run the installation 
silently. msiexec must be run as an administrator. 

Note: If you have more than one installation of CATIA installed, do not use the silent 
installer because it is not able to determine which installation to use. Instead, use 
the interactive installer because it prompts you to select the correct installation. 

To install silently 

Enter the following at the command line: 

msiexec.exe /i "<msi_file_full_path>" 

APRIORILOCATION=<aPriori_install> /quiet 

For example: 

msiexec.exe /i 

"C:\installfiles\CostInAPriori_for_SW2012_Installer_x64.msi" 

APRIORILOCATION=C:\aPriori /quiet 

To uninstall silently 

Enter the following at the command line: 

msiexec.exe /x "<msi_file_full_path>" /quiet 

For example: 

msiexec.exe /x 

"C:\installfiles\CostInAPriori_for_SW2012_Installer_x64.msi" 

/quiet 
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Installation Checklist 
Use the following checklist to make sure you have not missed any of the steps in the 
installation. 

Database 

▪ Installed MySQL, Oracle, or SQL Server, specifying all the recommended values 
and settings [[xxx]] 

▪ Created apriori schema 

▪ Created apriori_test schema 

▪ Created the apriori_training 

▪ Assigned permissions to apriori schema 

▪ Assigned permissions to apriori_test schema 

▪ Assigned permissions to apriori_training schema 

▪ Imported production database with license into apriori schema 

▪ Imported ‘standarddata’ into the apriori_test schema 

▪ Imported ‘standarddata’ into the apriori_training schema 

Client 

▪ Determine the location of the document cache 

▪ Determine if you want to use the silent installer 

▪ Install the client using the interactive installer 

▪ Test client by opening and costing a couple parts
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3 Update Installations 
Updates to existing aPriori installations usually take the form of either "maintenance" 
releases (Service Pack or Hot Fix) or "major" releases". (See Releases and Installation 
Types for more details.) 

All update installations require you first back up your existing client software. Then, like 
for a first-time release, install the new aPriori client software. 

Update installations do NOT require you to install database software unless you are 
transitioning from one database management system (DBMS) to another. For example, 
if you are changing from MySQL to SQL Server.  

Major release update installations usually require a database upgrade as part of the 
update installation procedure.  

Minor release update installations do not usually require a database upgrade or patch as 
part of the update installation procedure. An exception is when you upgrade from 2019 
R1 and 2019 R1 SP1 (and their hot fixes) to 2019 R1 SP2. These upgrades do require 
you to run a db patch script. 

Update installations typically require you to install the latest updates to aPriori Baseline 
Machining and Regional Data Libraries. 

ALL updates must perform a "compatibility" procedure to ensure that all updated clients 
can operate with the database after the update. 

A summary of the steps that you should and should not perform for different types of 
releases is provided in Summary of Required Procedures, in Chapter 1, Planning Your 
Installation. 

Back Up and Update the aPriori 
Professional Client 
The installation Wizard introduced in 2019 R2 provides you with the ability to 
automatically create a backup and then proceed with the update process. 

When done, you may need to run a database upgrade. Do not perform this step unless 
directed to do so for this release in 1, Planning Your Installation, or unless directed to do 
so by aPriori Customer Support. 
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Overview of Database Upgrades 
Perform the database upgrade portion of the following procedures only if you are 
upgrading an existing installation to a major release, and only if explicitly directed to do 
so by the earlier sections in this Installation Guide or by aPriori Customer Support. If you 
are NOT performing a database upgrade, you can skip that section and perform Update 
Deployment Links , Run the Compatibility Script, and the steps that follow them. 

aPriori is constantly improving the upgrade and migration procedure. Please read all the 
instructions in this chapter even if you have performed upgrades in the past. 

Types of upgrades 

There are three ways to perform a database upgrade: 

▪ Upgrade in place – Install the latest aPriori software connected to your existing, 
pre-update database, and then run the upgrade procedure against all aPriori DB 
schemas. You perform this process twice: once in a test environment on a copy 
of your production environment, and then once on your production environment 
itself. 

▪ Full migration – Export the old database, install the new aPriori software, then re-
import the exported database files into the new installation. 

▪ aPriori upgrade – Send your database to aPriori Customer Support for migration. 

Which method should I choose? 

"Upgrade in place" is relatively quick and simple and is the preferred. This streamlined 
method was introduced in aPriori 2015 R2. If you are an experienced aPriori customer 
and you have upgraded since 2015 R2, you may find the new upgrade procedure much 
simpler. If you are staying with your current database management system (DBMS) 
during your upgrade, this is the path you should take. 

Full migration is a manual and involved process which consists of many steps. It can 
take significantly longer than an "Upgrade in place". You should only choose this 
approach if you are moving an existing database to a new DBMS as part of this upgrade 
(such as moving from MySQL to SQL Server). aPriori may identify other circumstances 
which necessitates this approach. Full migration is described in Appendix A, Performing 
a Full Database Migration. Even if you perform this procedure yourself, you should 
consult with aPriori Customer Support to ensure that things go smoothly. 

The final option is to contract with aPriori to perform the actual migration. This process is 
described in Appendix B, Migration by Support. Only choose this path if you cannot 
perform an "Upgrade in place" and do not have the resources or the expertise to 
undertake a full migration. 
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Upgrading in a Test Environment 

Important: Major releases of aPriori often include significant changes which could result 
in variations with configured VPEs. It is a best practice to test all configured VPEs with 
the new release in a test or staging environment to understand the impact of changes 
before you deploy the new release in a production environment.  

MySQL considerations 

If you are currently using MySQL version 5.1, you also need to upgrade your version of 
MySQL to version 5.6 because 5.1 is no longer supported.  

Using MySQL Workbench, go to Options File and then the InnoDB tab, and ensure that 
innodb_buffer_pool_size is enabled and set to at least “1G”. 

Definition of Terms 

▪ Source version: This is the version of aPriori which you are currently running in 
production and from which you wish to upgrade. 

▪ Target version: This is the version of aPriori to which you would like to upgrade. 

▪ Baseline VPE: The starting point, off-the-shelf VPEs provided by aPriori which 
start with the word ‘aPriori’ followed by a geographic region (e.g. aPriori Eastern 
Europe, aPriori USA, etc.) 

▪ Regional Data Libraries: Extension to the starting point VPEs that contain 
targeted costing data for specific geographic areas.  

▪ Costing window: The aPriori window in which users normally work and where 
they would cost parts. 

▪ Migration computer: This is the computer that you use to perform a migration.  

General prerequisites 

To perform any type of upgrade or data migration, you must have: 

▪ A general understanding of aPriori. You must also have a working knowledge of 
the database management system you are using with aPriori (either MySQL, 
Oracle, or SQL Server). 

▪ Super user access to aPriori. If a super user does not exist, you must 
designate one before starting the upgrade.  

▪ Administrative access to the database server. 

▪ Installation files for the new version of aPriori. For more information, see 
Acquiring the Installation Files in 1. 

▪ System access to your DBMS tools. That is, the system where you are 
performing the upgrade or migration must have access to the tools for your 
database. For example, for Oracle, you must set the ORACLE_HOME 
environment variable and add it to your Windows PATH. Ensure that you (or a 
script) can run SQL*Plus (for example, %ORACLE_HOME%\bin\sqlplus.exe). 
Likewise, for Microsoft SQL Server, you must ensure that SQL Server 
Management Studio is installed on the machine where you are running the 
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updatedb.cmd script so that it can access sqlcmd.exe. Running the script on the 
SQL Server host ensures that this is the case. 

Note: If your upgrade requires upgrading through multiple releases (for 
example, from 2018 R3 to 2019 R1 and then to 2019 R2) you must start a 
fresh command console window each time you run updatedb.cmd. 
Otherwise, the old window may have environment variables set for the 
previous upgrade which cause the next upgrade to fail.  

▪ Hardware: For an upgrade, the staging and testing computer must be 
comparable to the production server, with enough disk space to accommodate 
the size of the current database. Supported operating systems: See the latest 
edition of the System Requirements document. 

It is a best practice to observe these precautions as a part of any major upgrade: 

▪ Back up everything before you start. 

▪ Create a testing environment where you can upgrade and extensively evaluate 
the upgrade before putting it into production. 

▪ Only perform the upgrade on your production environment after you are 100% 
confident that the upgrade does not introduce any unexpected changes for your 
users. 

▪ When you do upgrade your production environment, do so during an extended 
period of low system usage (such as a weekend) so that you do not interfere with 
the production work of your users. 

Update – Test Environment 
When you update, you perform the procedure twice: 

▪ Once on a copy of your production data in a test environment so that you can 
evaluate the changes introduced by the update. 

▪ Once on your actual production environment. 

Note that when you are working on a copy in the test environment, if your installation 
includes multiple deployments you must take extra care to ensure that the deployment 
copies do not contain pointers back to the production environment. We provide notes at 
critical points in the next section to ensure that you address such pointers. 

Prepare for the test update 

The details for the following steps vary with your specific DBMS type (MySQL, Oracle, or 
SQL Server) and with your in-house database administration procedures. For database 
operations, the following steps only specify the desired result. Your database 
administrator(s) must determine the specific procedures they wish to employ to achieve 
those results. 

1 Configure a testing system that is comparable to your production system and which 
has access to your database management system. 
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2 Create database dump files for each of the production database schemas that you 
need to upgrade. These files serve a dual purpose: as a backup, and as a way to 
copy your production data to the testing environment. 

3 Define new schemas (one for each existing schema) to be used for testing. These 
schemas should have names that are similar to the production schemas, but which 
also include a suffix or some other naming convention that identifies them as 
belonging to the new release (for example "16.2"). 

4 Import the dump files created above into each of the new testing schemas. 

 IMPORTANT: If you have more than one deployment and are working with a 
copy of your production environment, it is critical that you do not run the 
compatibility script until after performing the steps in the next section (“Update 
Deployment Links”). Upgraded deployments that are copies of your production 
environment can still contain pointers back to your production environment and 
running the compatibility script in this state can cause your production clients to 
stop working with your production deployments. Only proceed once you are sure 
that your test deployments point only to your test environment.  

Update Deployment Links 

You need to perform an additional client installation (with the old version) that points to 
the copy of your main deployment. (Later, the new client is used. However, the steps 
below must be performed using the old client version.) 

1 Log into the aPriori client as a system administrator with the previous version of the 
client.  

2 Click Tools > System Admin Toolset from the client menu bar. 

3 Click the System Administrator button on the System Admin Toolset window. 

4 For each deployment, click Deployment <name> from the left navigation pane in the 
System Administrator window and perform the following steps. 

5 In the Deployment pane, you must edit the fields to ensure that all values reflect any 
changes made to the test environment, and that nothing points back to the 
production environment from which it was copied. Do not make changes to the 
Inherits from Master option for any deployment (usually the Default deployment has 
this checked). If you make any changes, do so only to deployments that still have 
Inherits from Master unchecked. 
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6 To ensure that your changes are all valid, use the Test Connection button. 

7 When done with all deployments, in the System administrator tool bar, click the 

Publish Changes, , button. 

Continue with the update process 

1 Install the new version of aPriori on the testing computer system, specifying the 
updated schemas when prompted.  

2 Once you have installed the new version of aPriori, you cannot log in: aPriori 
displays an "incompatible version" error message. 

 

If your update requires that you upgrade your database, you must perform that 
procedure. In all cases, you must ensure that any deployment links point to the test 
system and not to the production system, and then run the aPriori "compatibility" script 
as explained in the next sections before you can log in again. 

Perform the database upgrade procedure 

If your update requires a database upgrade, you must run aPriori's database upgrade or 
patch script against every aPriori schema in your existing database. (For testing 
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purposes, the testing schemas are initially COPIES of your production schemas that you 
created in the "Prepare for the upgrade" section.)  

If you are upgrading to 2019 R2 (19.2.x.x) from any 2019 R1 release (19.1.x.x) you must 
run the upgrade script. 

IMPORTANT: See General prerequisites for important considerations when running the 
upgrade script. 

The upgrade script is in the following location of the new aPriori installation: 

<apriori_install>\bin\updateDB.cmd 

The scripts take the following arguments: 

▪ /dbflavor – Either mysql, oracle, or sqlserver. If oracle is 
specified, one of the following sub-arguments is 
required: 
{/sid <sid>|/servicename <servicename>} 

▪ /h – The host name of the server where the database is located. 

▪ /P – The port used by the database (typical values are 3306 for MySQL, 1521 

for Oracle, 1433 for SQL Server). 

▪ /schemaname – The aPriori schema to be upgraded. 

▪ /user – A database user account with privileges to modify the aPriori schema. 

▪ /password –The password for the privileged database user account for 

modifying the aPriori schema. 

Run the upgrade script 

 

1 From the command line, navigate to the bin directory of the test aPriori installation 
and run the database upgrade script against your old schema(s): 

updateDB.cmd /dbflavor [mysql| 

{oracle {/sid <sid>|/servicename <servicename>}}|sqlserver]  

/h <hostname> /P <port> /schemaname <schemaname>  

/user <user> /password <password> 

 

For example, for an Oracle database upgrade, the command lines might be similar to 

cd apriori_<vers>\bin 

updateDB.cmd /dbflavor oracle /servicename orcl.acme.com /h 

testhost01 /P 1521 /schemaname apdb1  

/user apadmin02 /password k73M06nn! 

The above is only an example. Make sure to substitute valid arguments for your 
particular situation. The script displays "updateDB complete" when done. 

2 If you have multiple schemas, repeat the previous step for each schema that needs 
to be updated. 
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Run the Compatibility Script 

All updates must run the compatibility script, regardless of whether you need to run the 
database upgrade script in “Perform the database upgrade procedure”. This script 
ensures that all updated clients are interoperable with the updated database. The script 
takes only <aP_username> and <aP_password> arguments. 

Note: Unlike the database upgrade procedure which needs to be run for every 
schema, this compatibility script must be run only ONE time. This updates the 
database to make it compatible with the new version of software. Therefore, it 
does not need to be done for each client installation. 

1 Open a command console and cd to the aPriori installation directory. 

cd <apriori_install>\bin 

2 Execute the script: 

updateCompatibleVersions.cmd <aP_username> <aP_password> 

For example: 

updateCompatibleVersions.cmd bsmith002 dm675KA 

Note: These are NOT the same credentials you may have used to upgrade the 
database in the previous section. Many users do not need to use their aPriori 
user ID and password regularly, and therefore may not know them. This means 
that your aPriori user ID is the same as your Window’s user ID. The password 
was created at the same time your aPriori user account was created. If you do 
not know it, use the aPriori System Administrator to reset your password. 

Install the VPE baseline update 

Most updates require you to perform an import of an aPriori Baseline Update. This 
changes some costing data in the aPriori starting point VPEs and makes other important 
changes. 

Concerns about changing costing data might make you consider skipping this step. 
Please note that the costing data in your configured VPEs are not changed, unless these 
are explicitly updated to match the newest cost data. 

IMPORTANT! If a baseline update is provided as part of an upgrade, this import 
cannot be skipped. If there are any concerns about this, then contact aPriori 
Customer Support before beginning your upgrade 

Note: It is recommended that you apply the baseline update while users are not actively 
using aPriori, but it is not a requirement. Be sure to notify users that this is taking 
place to avoid confusion since a cost estimate using a baseline VPE may 
change.  

1 If you are a super user, acquire the baseline update installation file and proceed to 
the next step in this process. For more information, see Acquiring the Installation 
Files.  

If you are not a super user, you cannot access the UI until the baseline update is 
installed, but you can import the baseline update using the cmdLine tool: 
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a. Open a cmd console and cd to aPriori installation directory: 

cd <ap_install>\bin 

b. Execute this script:  

loadBaselineUpdate <full_path_to_baseline_update_file> 
<ap_username> <ap_password> 

where ap_username is both an Admin & a VPE Admin 

2 Install the baseline update: 

a. Login to the aPriori client that you just installed. If you do not have a 
desktop shortcut, you can launch the aPriori client from the 
runStandaloneApriori.cmd script. The runStandaloneApriori.cmd script is 
in the \bin directory of the aPriori installation folder. 

b. Click on the Tools menu, then select VPE Toolset. 

c. From the VPE toolset, click the File menu, → Import → aPriori Baseline 
Update… 

d. Navigate to the file you downloaded. Note that if you used Internet 
Explorer to download the file, the file extension was likely changed from 
.apx to .zip. Therefore, when browsing for the file, you may need to 
change the “Files of type:” filter from .apx to All Files. 

 
  Note: Baseline updates must be imported into each deployment. 

3 After the baseline update has finished importing, test the installation to make sure 
everything is working properly. If so, remove the old version of the aPriori client 
software that was renamed in a previous step (C:\aPriori_old) and install the new 
version on the rest of the client computers. 

Acquire and install Regional Data Libraries 

If you have Regional Data Libraries in addition to the standard starting point baseline 
VPEs that ship with aPriori, contact aPriori Customer Support to download the latest 
files. Install these Regional Data Libraries for each deployment. Installation instructions 
are found in the Release Notes for the RDL release. 

Extensively test the update 

Test the updated installation to ensure that everything works the way that you expect. 
Once you are satisfied with the stability of the software, you can proceed to update your 
production environment. 
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Update – Production Environment 
Once you are confident in the update based on your testing, you can upgrade your 
production environment: repeat the steps you performed above in the test environment 
to your production environment during a quiet period. The procedure below assumes this 
approach.  

Prepare for the production upgrade 

As mentioned earlier, schedule this for a period of low system usage, and ensure that all 
your data is backed up. 

1 Back up all your production schemas. Note that for the production upgrade, the 
dump files are strictly to ensure data integrity. You do not re-import these schemas 
as part of the upgrade process. 

2 Install the new version of aPriori on the production computer system(s). 

Perform the update, adjusting as necessary 

Repeat the procedures that you followed for testing, from Perform the database upgrade 
procedure (if applicable) through Acquire and install Regional Data Libraries, adjusting 
as necessary to reflect that you are working with your production environment rather 
than the testing environment. 

This completes the update procedure. You can skip over the rest of the chapters in this 
guide. 
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A. Performing a Full 
Database Migration 

This chapter provides the detailed steps required to perform a full database migration. 

Usually this is not necessary. Most aPriori database upgrades are handled by the 
simpler "Upgrade in Place" procedure documented in Perform the database upgrade 
procedure in 3. 

However, in certain circumstances (such as changing from one DBMS to another at the 
same time you upgrade aPriori), you need to perform the full migration procedure 
described here. 

Note that you also have the option of having aPriori perform the upgrade and migration. 
If you would like to pursue this option, contact aPriori Customer Support and then follow 
the procedures in Appendix B, Migration by Support. If you plan to send your database 
to aPriori Support to so they can perform the migration, or if you are performing your 
own "upgrade in place", you can disregard the rest of this appendix.  

If you need to use this procedure, you should still work with aPriori Support if this is your 
first time performing a data migration.  

Caution: Read this entire appendix before attempting or scheduling your upgrade. The 
upgrade procedure has many steps and it is important that it is fully tested with 
your data before upgrading the production system.  

Prerequisites for migration 
In addition to the items listed in General prerequisites, you must also have the following 
for the migration procedure: 

▪ The source version of aPriori: 

https://transfer.apriori.com/download/p/aPriori_<version>_migration_

exp.html 

▪ A database schema file compatible with the new version of aPriori: 

https://transfer.apriori.com/download/p/aPriori_databases_<version>.

zip 

There are two database files: migrationdata for the master database and 
standarddata for additional deployment databases (if necessary). 

▪ Hardware: The database migration process is data intensive. The exact system 
requirements necessary for the migration computer depend on the size of the 
database that is being migrated. It is important to test the migration with the 
machine that you use for the production upgrade, so you know it is capable. The 
computer must be on the same LAN as the database server. Any latency 
between the database and the client performing the migration slows the process 
down immensely. 

Memory: 6 GB (possibly more for very large databases) 
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Disk Space: 2x the size of the database. Recommended: Solid State Drives (SSD) 
for faster performance. 

Note: If the source release uses an encrypted connection, then for the 
updateCompatibleVersions script to work, the SSL certificate must be imported 
into the target client.  

Overview of Steps 

1 Setup the source version. 

2 Export the data out of the source version. 

3 Setup the target version and database. 

4 Import the data into the target version. 

5 Test the VPEs. 

6 Plan and schedule the production upgrade. 

7 Reload the database export. 

8 Execute the differential update. 

9 Upgrade the client software. 

Data Export 

Note:  You should either copy your database to a test environment or perform this test 
during times of low aPriori usage because the procedure in this chapter may 
impact the performance for other users. 

Set up the Source Version 

1 On the database server, create another database schema to serve as a copy of the 
production data. 

Oracle: If you use Oracle, please ask your DBA to create a copy of your production 
database in a test environment.  

MySQL: If you use MySQL, follow these steps: 

• Start MySQL Workbench 6.0 
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• Click the New Schema ( ) icon from the toolbar. 

 

• Enter a unique name for the database, such as apriori_upgrade in the 
“Schema name” field and click Apply. Then click Apply again, and finally 
click Finish. The apriori_upgrade schema is in the list of schemas on the left.  

• Select “Users and Privileges” from the list in the top left panel 

• Click on the user that is named “apriori”, then select the Schema Privileges 
tab from the upper right side 
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• Select the Add Entry button located on the right, mid page 

 

 

• Click on “Selected Schema” radio button then highlight your new schema 
and click OK 

• Select user beneath User Accounts 
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• Select all the options under Object Rights and click Apply 

 

• Close MySQL Workbench 

• Repeat the previous steps for each additional deployment schema/database 
you are migrating. 

2 Copy the data from your production schema to the upgrade schema. 

• On your MySQL server, open a command window. 

• The following steps use the mysqldump.exe and mysql.exe commands. If the 
MySQL bin directory is not in your PATH environment variable, Windows 
does not know where these commands are located. Therefore, you may have 
to supply the full path to the command. It is in the MySQL installation 
directory, which is often \Program Files\MySQL\MySQL Server 5.6\bin. Note 
that you may not have write permission to this folder, so if your command 
prompt is at that directory, you may need to specify a different location for the 
location of the file. You can also find mysqldump.exe and mysql.exe in the 
aPriori\bin directory if the aPriori client is installed. 

• Enter this command to export the data from the production schema (this 
assumes the production schema name is “apriori”):  

mysqldump.exe –user=root –password=password apriori > 

apriori_upgrade.sql  

Enter this command to import the data into your new upgrade schema: 

mysql.exe –user=root –password=password apriori_upgrade < 

apriori_upgrade.sql  

• There is no status indicator showing the export progress. However, when the 
export is complete the command prompt window reappears and displays a 
new line for user input. If there are no errors shown, then proceed with the 
migration. 

• Repeat the above steps for each additional deployment schema/database 
you are migrating. 
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• Keep the command window open for the next step. 

3 On the migration computer, install the source version of aPriori. The installation 
media is listed in the prerequisites section at the beginning of this guide. It is 
important to use this version of software because it contains fixes directly related to 
migration., Install as you would normally, except change the name of the installation 
from the default of ‘apriori’ to include the version (e.g. ‘apriori2016R1’) and point to 
the database schema “apriori_upgrade”.  

4 Upgrade the source database to be compatible with the latest version of the source 
release you just installed. Doing so allows the new source version of the software to 
open.  

• Open a command prompt in the \bin directory of the aPriori installation folder 
where you just installed. 

• Enter this command to upgrade the source database to the latest version of 
aPriori: 

updateCompatibleVersions.cmd <user> <password>  

where user and password pertain to an aPriori user account with system 
administrator privileges. If the build shows “successful” with no errors, then proceed 
with the next steps. 

5 Edit the file called runStandaloneApriori.cmd located in the \bin folder where you just 
installed aPriori.  

• Change the amount of memory allocated to aPriori on line 18. The amount of 
memory in megabytes immediately follows “-Xmx”. The size of the database 
and physical memory on the machine determines the amount of memory that 
you need to allocate to aPriori. Change the default value to 4096m and higher 
if you have more than 6GB of memory installed. Make sure to leave 2GB for 
the operating system and other applications. Allocating too much memory to 
aPriori could result in paging which severely degrades performance.   

•  (Optional) Change the cache location. aPriori uses your user home directory 
to cache data during the upgrade procedure. This location is typically: 

C:\users\<username>\AppData\Local\aPriori.  

If you do not have at least the same amount of space available on the C: drive as the 
size of the database, you must change the cache location to a disk that has enough 
space. Do so by adding the following line to the start of runStandaloneApriori.cmd. 
Replace “D:\temp\cache” with your choice of cache location: 

set localappdata=D:\temp\cache 
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Export data out of the Source Version 

1 On the migration computer, create a new folder in which to save the migration 
export data. Do so on a drive which has at least the same amount of space as the 
database. For example, D:\migration_export_data\ 

2 Go back to the main aPriori window. From the Tools menu, select Migration > 
Export Migration Data. 

 

3 aPriori displays a list of all your schemas. Select all the schemas you want to export 
for migration. Typically, you only migrate the production schemas and do not migrate 
test or training schemas. 
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4 Save the export file to the folder that you created earlier. The amount of time it takes 
to export the data depends on the size of the database, the speed of the connection 
to the database, and the hardware of the computer. It could take as little as 30 
minutes and as long as several hours. Once it is finished, aPriori information for all 
schemas selected are saved to disk in a version neutral format. 

5 The export is now complete. Close the aPriori client. 

Data Import 

Setup the target version 

1 On the database server, create another database schema to use for importing the 
migration data for testing purposes. If you use Oracle, please ask your DBA to do 
this. If you use MySQL, follow the same steps as you did previously to create (a) new 
database schema(s) and add permissions for the user “apriori”. This time give the 
new schema a different name such as including the current version, for example: 
"apriori_2016R1". 

2 On the database server, import the migrationdata dump file into your new master 
database schema, and import the standarddata dump file into any other database 
schemas. Use the section below that reflects your database management system. 

Note: If you only have one database schema, that is your master database schema. 
If you have multiple database schemas, one of them is the master. The 
master schema is the one which contains users and license information. It is 
also the database that was entered at the time you installed the aPriori client 
software and is referenced in the hibernate.properties file (found in the aPriori 
installation’s home directory). 

ORACLE: Ask your DBA to import the following files using Oracle’s impdp utility: 

migrationdata<version>_oracle.dmp into the new master schema 
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standarddata<version>_oracle.dmp into any other schemas.  

The details of the database dump files including the user and tablespace from which 
they were exported are included in the readme.txt file inside the zip file containing 
the database dump files. The databases can be remapped to a different user and 
tablespace. 

MySQL: Follow these steps: 

From a command prompt use the following command to import the database file to 
your master database: 

mysql –user=root –password=<rootPassword> aPriori_<version>  

< migrationdata<version>_mysql.sql 

The command prompt disappears while the data is importing. It takes a few minutes 
for the import. After the data is imported successfully, the prompt returns with no 
message. You know it imported successfully if no error messages are displayed. 

If the MySQL \bin directory is not in the PATH environment variable, Windows does 
not know where to find the mysql.exe file. Therefore, you may have to enter the full 
path: 

\Program Files\MySQL\MySQL Server 5.6\bin  

If migrationdata<version>_mysql.sql is not in the same folder as your 

command prompt, either move it to that folder, navigate to that folder in the 
command window, or provide the full path to the file. 

Repeat the above steps to import standarddata<version>_mysql.sql for each 

additional deployment schema/database you are migrating. Keep the command 
window open for the next steps. 

3 On the migration computer, install the target version of aPriori in the same manner 
you would install any other version. These are the exceptions from default when 
installing.  

• Change the name of the installation from the default of apriori to also include 
the version (for example, apriori2016R1).  

• Make sure you point it to the new database you just created and to which you 
imported the file. 

4 Allocate additional memory. Most databases require additional memory beyond the 
default of 1280Mb. To do this, edit the file <apriori_install>\ext\migration-import-
plugin\plugin.properties. Find the line towards the bottom of the file: 
launcher.max.memory=2048m. Change 2048 to 4096, then save and close the file. 

Import the data into the target version 

1 On the migration computer, launch the target version of aPriori by running the 
runStandaloneApriori.cmd script found in the<apriori_install>\bin directory.  

2 Log in with username = migration and password = migration.  

3 From the Tools menu, select System Admin Toolset. 
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4 Click Migration Import Tool. Refer to the following screenshot as you proceed 
through the rest of this procedure. 

 

5 Click the ellipsis (…) button to the right of the Migration file: field. Browse to the 
folder where you saved the migration export from the old database and select 
MyExport.migrationexport.xml, then click Open. 

6 If a message appears that the schema descriptors do not match, click Import 
Schema Descriptors. 

• When asked whether you wish to proceed, click Yes 

• When the import completes, click OK 

• The System Administrator window opens. If you are only migrating one 
database schema, no further action is needed here. If you are migrating 
multiple schemas you must ensure that the Inherits from Master box is 
checked only for the master schema. 

• Save changes. 

7 Return to the Migration Import Tool window and click Start, then OK to confirm the 
start of the migration import. If you made a mistake and are attempting to import into 
a database that is not empty a warning is generated. If you get this warning, double 
check the database connection information in hibernate.properties and in the System 
Administrator window. 

8 The status of the migration is displayed at the bottom of the window as the data is 
imported into the new aPriori database. The amount of time it takes to import 
depends on the size of the database. This typically takes about 50% longer than it 
took to export the data. 
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9 When the migration is complete, a pop-up window appears, the migration window 
closes, and you are logged out.  

Testing 

Test the VPEs 

It is important to test configured VPEs and reports to make sure they are compatible with 
the new version of aPriori. At the time your VPEs were configured, a VPE test and 
calibration plan may have been created. If so, run that test plan in the new version of 
aPriori. 

If you do not have a test plan already, one approach is to open and cost a set of parts in 
both versions and compare the results of each. An easy way to do that for many parts is 
to create a roll up in each version and add the same parts to each rollup. Note that there 
are differences in the cost of the same component in each version. 

aPriori publishes release notes as well as a detailed list of changes to the cost models 
that cause differences in the costs between versions. Please refer to those documents 
for specific changes.  Here are typical reasons for cost changes. 

1 Improvements to geometry extraction. 

• If you are costing the same CAD file in 2 different versions of aPriori, the way 
in which aPriori analyzes the geometry may differ. Improvements are often 
made which allows aPriori to more accurately and granularly interpret the 
geometry. If you are re-costing parts in the database that are not connected 
to a CAD file, these types of changes are not relevant. 

2 Changes to baseline VPE cost model logic 

• Baseline VPEs: The aPriori baseline VPEs are based on logic from the 
baseline cost models. The baseline cost models often change with a new 
release of software to include new functionality. This is very likely to change 
cost estimates when using the baseline VPEs. 

• Configured VPEs: Configured VPEs also typically inherit costing logic from 
the baseline cost models. However, the baseline cost models are versioned. 
New functionality is only put into new versions. VPEs inheriting from baseline 
cost models continue to inherit from the same version. Therefore, there is 
likely no change to the cost model from which the VPE is inheriting. Bug fixes 
are an exception to this. 

• The above is true for both overlay (inherited) VPEs as well as standalone 
VPEs. However, with overlay VPEs, you can easily update the version from 
which it is inheriting from the VPE Manager. 

3 Changes to baseline VPE labor and overhead rates. 

• For standalone VPEs, these changes have no effect. For inherited VPEs and 
baseline VPEs these changes result in an expected cost difference. 

4 Improvements to cost engine. 
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• These types of changes are less likely to cause a difference than the ones 
above. However, it does happen on occasion. For example, in 2015 R2, 
improvements were made to the sheet metal nesting algorithm which could 
result in more parts per sheet, which increased the material utilization and 
decreased material cost compared to older versions. 

Moving to production 

Plan and Schedule Production Changes 

Once you have successfully tested the new version of aPriori, you can plan your move to 
production. Schedule the production move for a date and time when you can suspend 
use of aPriori completely for a period of time. This process typically takes a day, and it is 
recommended to leave two days in case extra time is needed for unforeseen issues. 

Notify all aPriori users about the time-schedule for the move and indicate that the 
application is unavailable during migration.  

The following steps explain how to find the scenarios in the production database that 
have been updated since the first migration took place. Run this at least two days prior 
to the production move, and again at the time of the production move. This process 
minimizes the time for the production move and gives a sense for how long the move 
takes. 

1 Prepare for the production move by importing the upgraded database you migrated 
previously into a production schema. 

IMPORTANT! At this point you still require both the old and the upgraded databases. 
Therefore, do not import the new database into the same schema as the old! 

2 At this point in time all users should stop using aPriori. Any changes made with the 
old version after this point are lost. 

3 The following steps explain how to export the scenarios that have been created or 
updated since the old database was exported.  

• Open the old version 

• Select File > Export > Select Scenario(s) 

• On the left side of the search box under Time Selection, select From 

• Enter the date you last exported the database. (leave the To field empty) 

• To find all scenarios created or updated since the chosen date, click the Find 
button. 

• Click on the first scenario to select it, then press CTRL A to select all, then 
click OK. 

4 Save the apriori.scenarios.ap file. The following steps explain how to import the 
scenarios into the new database. 

• Open the new version of aPriori. 

• Select File > Import 
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• Browse to the location you saved the apriori.scenarios.ap file that you 
exported from the old version. Select the file and click Open. 

• This imports those scenarios to the new database and completes the move to 
the new database. 

5 If any VPE changes were made since the initial database export, export those VPEs 
out of the old version and import them into the new version. 

6 If any other changes had been made to the old version such as users or site 
variables since the initial export, make those same changes in the new version. 

7 Once all data in the new database is up to date, disable the old database to ensure 
no users continue to use it. This can be done by changing the database password or 
by dropping the database. 

Upgrade the Client Software 

1 Install the aPriori client software as described in Installing the aPriori Professional 
Client. If you changed the name of the schema, be sure to use that schema name 
when installing the client software. 

2 When installing the new version of aPriori, do not install on top of the previous 
installation. Remove the previous version before installing the new one. 

3 Verify the client is working correctly by launching aPriori and opening and costing 
several parts. 
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B. Migration by 
Support 

If you are going to have aPriori perform your database migration, follow the guidelines in 
this chapter. 

Overview of steps 

1 Two to four weeks before the date you plan to implement the new release in your 
production environment, contact aPriori Customer Support (support@apriori.com) to 
inform them that you would like them to complete the migration. This allows time for 
testing and potential debugging. 

2 Export a copy of your production database and send it to aPriori. Starting now, until 
the production migration, please limit making any system-wide changes such as to 
variables or users.  

When you move to production you can easily update the migrated database with any 
cost estimates (scenarios) that have changed since the copy was made, but there is 
no easy way to update other types of data. If you must make these types of changes, 
please document what has been done so they can be done again in the updated 
database.  

3 aPriori: 

• migrate the data and test against the new version. 

• assess configured VPE changes and scope amount of work required (if any). 

• provide a time frame for any VPE reconfiguration to be done (if necessary).  

• send the migrated database back to you. 

4 (Highly recommended) Install the new release in a staging environment and conduct 
independent testing of custom VPEs as well as of general compatibility with your 
systems, hardware, CAD environment, etc.  

5 (Optional) Meet with aPriori Support to answer any questions about how to move 
from staging to production. 

6 Move from the tested, staging environment to production: 

• Disable access to the older, production database. 

• Use the aPriori client software to export any data from the older production 
database that has changed since the database was exported. 

• Import the migrated database to the new production database schema 

• Use the aPriori client software to import into the new database the changed 
data that you exported above. 

• Install the new client software and connect to the migrated database 

mailto:support@apriori.com
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Exporting, importing, and testing 

1 Export the database. Make a note of the date and time you export the database. 
Users may continue to use aPriori at this time. 

Oracle notes: 

• Have your database administrator export the database using the expdp 
command. 

• The maximum file size our support site can handle is 2GB. Therefore, limit 
the size of the files to 3GB using the FILESIZE parameter. After zipping the 
files, they should be less than 2GB. Do not use the Linux/Unix pipes to split 
or compress the export. aPriori Support uses Windows servers and therefore 
cannot use these files. 

• Create the log file when exporting and send it along with the database. This 
log file contains important information that aPriori Support needs to perform 
the migration.  

MySQL notes: 

• On your MySQL server, open a command window. 

• The following step uses the mysqldump.exe command. If the MySQL bin 
directory is not in your PATH environment variable, Windows does not know 
where this command is located. Therefore, you may have to supply the full 
path to the command. It is in the MySQL installation directory, which is often 
\Program Files\MySQL\MySQL Server 5.6\bin. Note that you may not have 
write permission to this folder, so if your command prompt is at that directory, 
you may need to specify a different location for the location of the file. You 
can also find mysqldump.exe in the aPriori\bin directory if the aPriori client is 
installed. 

• Enter this command (this assumes the schema name is “apriori”, and the 
username, and password are both “admin” – also, replace companyname 
with the name of your organization):  

mysqldump.exe –user=admin –password=admin  

apriori > apriori_<companyName>.sql 

2 Zip the database file(s) generated in the previous step and upload to 
transfer.apriori.com/dropbox 

3 If the zip file is greater than 2GB, use the feature in Winzip to split the file into 
multiple files less than 2GB, or use File Splitter (available for free at 
www.filesplitter.org) to split the file.  

NOTE: Please inform aPriori Support as to how you have split the zip file.  

4 Send an email to support@apriori.com stating your database has been uploaded. If 
this is an Oracle database, also include the log file generated during the export 
process. 

5 aPriori migrates the data and test against the new version. 

mailto:support@apriori.com
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6 aPriori assesses the VPEs for compatibility with the new version and estimate how 
much effort is required to make them compatible. 

7 aPriori communicates the amount of time they need to complete the VPE work. 

8 aPriori sends the database back to you in the upgraded format. 

9 Import the upgraded database. 

Oracle – Have your database administrator import the database using the impdp 
command. Any relevant details such as the schema name and tablespace name 
used during the migration process is communicated along with the database file 
itself. 

MySQL – Open a command line on the database server and execute these 
commands (use the actual name of the file that you downloaded):  

mysql.exe –user=admin –password=admin -e "CREATE DATABASE 

apriori_<version>” 

mysql.exe –user=admin –password=admin apriori_<version> < 

<name_of_db_file>.sql 

10 Download the latest aPriori software as described in Acquiring the Installation Files. 

11 Install the aPriori software for testing as described in Installing the aPriori 
Professional Client.  

Note: When installing for testing purposes be sure to install to a different directory 
than the existing installation folder. For example, if you have version 2015 R2 
installed in: 
 
C:\aPriori  
 
then install this version to: 
 
C:\aPriori_2016R1 

12 Proceed to test the new software. Test all custom VPEs; opening parts from a CAD 
file; using any aPriori CAD plugins; using aPriori in any normal workflows; etc.  

Moving from Testing to Production 
These are the steps that need to be taken at time of the actual migration of the 
production system. 

13 Prepare for the production migration by importing the upgraded database into the 
production schema. 

14 Install the latest client software in at least one place, pointing to the production 
schema. 

15 At this point in time all users should stop using aPriori. Any changes made in the 
older version of aPriori after this point are lost. 
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16 The following steps explain how to export the scenarios that have been created or 
updated since the database was exported.  

• Open version the old version of aPriori. 

• Select File > Export > Select Scenario(s) 

• On the left side of the search box under Time Selection, select From. 

• Enter the date you last exported the database. Leave the To field empty. 

• To find all scenarios that are new or updated since the date you entered until 
now, click the Find button. 

• Click the first scenario to select it, then press CTRL A to select all, then click 
OK. 

17 Save the apriori.scenarios.ap file. The following steps explain how to import the 
scenarios into the upgraded database. 

• Open Version the new version of aPriori. 

• Select File > Import 

• Browse to the location you saved the apriori.scenarios.ap file that you 
exported from the old version. Select the file and click Open. 

• It imports those scenarios to the upgraded database, which completes the 
migration to the upgraded database. 

18 Uninstall the old client software. You can use the uninstall.exe located in the aPriori 
installation folder or Add/Remove Programs from the Control Panel to uninstall. If 
you do use one of these methods, please make sure that all the files have been 
removed. If they have not, delete them manually. You may also just delete the files 
manually without running the uninstaller. 

19 Install the new version of aPriori in your production environment and connect to the 
migrated database. 
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C. Troubleshooting 
aPriori as a Creo Toolkit 
Application 

After the setup of aPriori as a Creo toolkit application, it is common for aPriori to fail to 
start the first time you attempt it. This can be for several different reasons, which can be 
easily addressed. 

No Error Message 
If you do not get any error message, the problem is likely due to an error in the 
configuration of the config.pro, protk.dat, or both.  

The most common configuration is to have a config.pro in the Creo startup directory. If 
you do not know where your startup directory is, you can find it in Creo by clicking on 
Help > System Information. Scroll down to the Directories section and look for the 
“Creo Parametric Startup Directory:”.  

The toolkit file (ending in protk.dat) is in the aPriori installation folder and contains the 
path to the aPriori .dll and text directory. This file is automatically generated when aPriori 
is installed and should only need to be modified if the location of the aPriori installation 
changes.  

aP Wrapper Failure 
You may get one or more of the following messages in Creo®. 

▪ Startup of application “aP Wrapper” failed. 

▪ Foreign program “aP Wrapper” failed to initialize:  

error PRO_TK_GENERAL_ERROR 

▪ JVM creation failed! 

The most common reason for these messages is that the computer is missing the 
Microsoft® Visual C++ runtime files. Close Creo®, and install the files according by 
running: 

\aPriori\install-files\runtimes\installRuntimes.cmd 

Another common reason for the “aP Wrapper” failure message on 32-bit machines is 
related to memory. aPriori requires a 64-bit computer in order to run aPriori as a Creo 
toolkit application.  
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D. SQL Server Export 
Tools 

You have at least two tools that you can use to export a SQL Server database: 

▪ SQL Server Management Studio (SSMS) 

▪ aPriori’s internal sqlServerExport PowerShell script 

Export using SQL Server Management 
Studio (SSMS) 
To create a dump from SSMS, right-click a database and select Tasks -> Generate 
Scripts... 

 

This opens a wizard. In the 'Choose Objects' section select 'Tables': 
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Open the Advanced options dialog and disable 'Script USE DATABASE' (this lets you 
import the dumped data into another, differently named, database instance). Set 'Types 
of data to script' to 'Schema and data': 

 

Exporting using aPriori’s PowerShell 
script 
aPriori provides a PowerShell script that dumps the contents of a database to a .sql file 

(this is somewhat similar to MySQL's mysqldump command): 

sqlServerExport.ps1  

Although this was originally developed for internal aPriori use, we are making this tool 
available to our customers. 

The script includes some basic usage information which can be viewed as follows: 

get-help sqlServerExport.ps1 -detailed 
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For example, to dump the contents of a database named 'apriori_15.2’: 

sqlServerExport.ps1 -server 'localhost,1433' -user apriori -pass 

apriori -db apriori_15.2 -out dbdump.sql 

To use native authentication simply omit the '-user' and '-pass' parameters. 

To load this dump into another database, first create a new database, then import the 
dump into that new database ('apriori_copy' in this example) using sqlcmd: 

sqlcmd -S "localhost,1433" -d apriori_copy -i dbdump.sql 

Note: The 'SQL Server PowerShell provider' must be installed on the machine where the 
script is run. This is included in SQL Server's Management Tools - Basic install 
feature and can be installed independently of the SQL Server: 

 

Note: Dumping a large database might be best performed on the server itself to avoid 
shipping the entire database over the network. 
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